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1

 C H A P T E R  1

G e t t i n g  S ta r t e d
This chapter is organized as a series of tours, each designed to help you 
understand how to create, configure, and manage workflows. You’ll also 
learn how to submit media to workflows for processing.

As you take these tours, you’ll also become familiar with important 
Vantage concepts and how you can use them to design workflows to 
meet your processing requirements. The more you know about Vantage, 
the better it will serve your automated media transcoding requirements.

Because each tour builds on the skills and knowledge you learn in the 
previous tours, we recommend that you take the tours in succession.

As you gain hands-on experience creating workflows and processing 
media in Vantage - which leads to a working knowledge of Vantage and 
its components and architecture - you’ll gain proficiency in using Vantage 
to solve your organization’s media processing problems.

Note: Sample MPEG2 media files are provided for use in these 
workflows: <Install_Drive>:/Program Files/Telestream/Vantage/Store. 
Files: FlipDemo.wmv (48 seconds), FlipDemo_short.wmv (15 seconds), 
and FlipDemo.mss.

Tours  Tour 1: Introducing Vantage & Transcoding Workflows

 Tour 2: Transcoding Files Using Settings You Want

 Tour 3: Using Binders in Workflows

 Tour 4: Using Variables in Workflows

 Tour 5: Decision Making in Workflows

 Tour 6: Dynamic Parameters

Note: You can take tours 1 through 4 without a license. For tours 5 and 
beyond, you’ll need a license to execute the workflows. Also, without a 
license, you can only transcode WMV files. For a demo license, contact 
sales@telestream.net.

http://www.telestream.net/vantage/help
mailto:sales@telestream.net


Tour 1: Introducing Vantage & Transcoding Workflows2
TOUR 1: INTRODUCING VANTAGE & 
TRANSCODING WORKFLOWS

This hands-on tour takes about an hour to an hour and a half (the longest 
of all the tours), and introduces you to the big picture of Vantage - the 
concept and process of creating a typical transcoding workflow, 
submitting media to transcode, monitoring your job as it executes, and 
viewing the results.

Tour Overview This tour is designed to provide your first hands-on experience with 
Vantage Workflow Designer. In this tour, you’ll learn the following:

 What is Vantage?

 Starting Vantage Workflow Designer

 Introducing Workflows

 Working with Workflows

 Setting up Actions

 Vantage Folders

 Activating Workflows

 Monitoring your Workflow Status

 Submitting Jobs

 Playing your New File

 Deactivating Workflows

What is Vantage? Vantage is a powerful workflow design and automation product that 
allows you to build highly automated, adaptive media processing 
workflows. Vantage combines a wide range of workflow design and media 
processing capabilities into a single program, and allows tight coupling 
between components so that workflows can make decisions and execute 
custom rules (as necessary) to solve a broad set of operational problems.

Vantage can be installed on a single server or installed as an array of 
servers, all working together to provide scalability and durability. In either 
case, a Vantage database is used as the central point for workflow design 
and execution. Services execute the workflows, coordinating with each 
other through the Vantage database; this central database also stores job 
history and other information about workflows.

You configure, operate, and manage Vantage using two multi-user 
Vantage programs: Vantage Management Console and Vantage 
Workflow Designer. Both programs connect directly to the database, so 
they can be run on any machine that can access the Vantage database.

Vantage Domain 
Console

The Vantage Management Console (usually referred to as just console) is 
the program you use to configure and administer your Vantage domain - 
including Vantage services, licenses, workflow design items, and the 
workflows themselves.
August 2010
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Vantage Workflow 
Designer

Vantage Workflow Designer is the program that enables you to design 
and automate workflows to meet your organization's transcoding 
requirements.

Workflow Designer allows you to activate and deactivate workflows, and 
allows you to submit and monitor the jobs that are created as workflows 
perform transactions on media you've submitted for processing.

Starting Vantage 
Workflow 
Designer

To start Vantage Workflow Designer, double-click the Vantage Workflow 
Designer shortcut on your desktop.

Figure 1. Vantage Workflow Designer desktop shortcut

Or, select start > Programs > Telestream > Vantage > Vantage Workflow 
Designer.

When Vantage is installed, no categories or workflows are stored in its 
database. You may have to create a new category to get started. If you’re 
being prompted to create a new category:

Figure 2. Create New Category window

1. Enter the name <YourName> Vantage Workflows and click OK. 
This allows other Vantage users to create their own Vantage 
Workflows category. (For tour purposes, the category is simply 
Vantage Workflows.)

2. When Workflow Designer prompts you to create a workflow, just click 
Cancel. You’ll create your first workflow in just a moment.

Introducing 
Workflows

A workflow in Vantage is a series of actions - arranged and configured by 
you - to automate a specific task or group of tasks.

Vantage Workflow Designer is the program that enables you to design 
and automate workflows to meet your organization's transcoding 
requirements.

Vantage provides several types of actions which you can use to build a 
custom workflow. For example, a watch action continually polls a hot 
folder (such as a broadcast server directory or a local or network folder) 
for incoming media to process - which Vantage performs by automatically 
submitting a job to the workflow you've created.
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Each action is executed by a Vantage service - for example, the watch 
action is executed by its companion watch service.

The Workflow 
Designer Window

Vantage Workflow Designer window has two panels. The left panel is the 
workflow panel. You organize workflows by category, in folders for easy 
access. The right panel includes a Workflow Design tab, a Monitor Status 
tab, and a Job Status tab.

The Workflow Design tab is a design space you can use to create and 
update your workflows. As you design (or modify) a workflow, all of the 
changes you make to the workflow are automatically stored in the 
Vantage database. You don't ever need to explicitly save your workflows - 
that is done automatically for you, and all others in your organization 
using Workflow Designer.

Once you've designed a workflow, you can activate it - starting its monitor 
task. When you activate a workflow, the Monitor Status tab allows you to 
view all of the workflow monitors - such as a watch action polling a hot 
folder for media files - that are active and discovering files to process as 
they are placed in the folder.

When a monitor finds a new file, it starts a job. You use the Job Status tab 
to view all of the running jobs for the currently selected workflow. You can 
view the task-by-task details of jobs, and watch them execute. Further, 
both the Monitor and Job status tabs allow you to see a history of 
previous jobs and monitor sessions.

You'll learn how to use both the Monitor Status tab and the Job Status tab 
in upcoming tours.

Creating a Category 
and a Workflow

If you haven’t yet created a new category for your own use, lets create 
one to get started (or skip to step 3), then we’ll add a workflow to it.

1. Select File > Create New Category to display the Create New 
Category window:

2. Enter <YourName> Vantage Workflows in the Name field and 
click OK. Adding your name to the category allows other Vantage 
users to create their own Vantage Workflows category. For tour 
purposes, the category is displayed simply Vantage Workflows.

Note: Vantage displays Welcome tips as you use it, to help you become 
familiar with its features. If you don’t want Vantage to display them, 
check Don’t show me this again before clicking OK.
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3. Next, create your first workflow - select File > Create New Workflow:

4. Enter the name Simple Transcode (in your Vantage Workflows 
category), and click OK.

At this point, your new workflow is automatically added to the Vantage 
database and to the list in the workflows panel - you can start creating its 
functionality.

Selecting a Workflow You can view your categories and workflows in the workflow panel, on the 
left. You should have your own workflow category with one new workflow, 
which is currently empty (no actions):

Figure 3. Vantage Workflow Designer’s design space.

Workflow panel - 
workflows organized by 

Workflow title bar.

Actions toolbar. Workflow design space. Workflow buttons.
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Adding Actions to a 
Workflow

In this tour, you’re going to build a simple workflow that watches a hot 
folder, transcodes a media file, and copies the result to a new location.

In the Workflow Design tab, notice that a set of action groups are 
available in the actions toolbar at the top of the workspace.

5. Open the monitor action group in the actions toolbar (by clicking the 
arrow in the upper left corner) to display the watch and associate 
actions.

Figure 4. Actions are grouped by functional category.

6. The watch action polls a hot folder for new media - click and drag it 
into the workspace to add your first action to the workflow. (Notice that 
it automatically centers itself - Vantage visually optimizes workflow 
actions automatically.)

Figure 5. Click and drag actions into your workflow.
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7. Next, open the transcode action group and click the Encode action. A 
comprehensive list of pre-set encoding actions displays:

Figure 6. Selecting preset actions reduces configuration tasks.

8. Select Web > QuickTime > QuickTime H.264 with AAC. The new 
action (pre-configured) is added to the workflow and automatically 
displays to the right of watch.

Deleting Actions To delete an action from a workflow, use the delete icon. At the top right 
of the action, a red X (delete) icon displays, which allows you to delete the 
action from the workflow. Don’t delete any actions from this workflow!

Note: Remember that actions are automatically re-arranged as you 
make changes. If you delete a connector or action, re-arranging may 
make a mess of things! Consider temporarily suspending auto-arrange 
by holding down the Control key (note the yellow button at the bottom 
highlights) until you’ve got all your actions in the workflow and 
connected.

Connecting Actions Now, you can connect the two actions together.

9. Click and drag a connector line from the yellow connector pin on the 
right side of the watch action to the yellow connector pin on the left 
side of the encode action. (Connector pins display in yellow until 
they’re connected.)

Actions connect automatically when you drag them into a workflow and 
bump them up to an existing action.
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10. Open the transport action group and drag the copy action so that your 
cursor is directly over the right side pin of the encode action (it 
highlights blue, as shown below). 

Figure 7. Bump the new action right up to another action.

When the blue bar displays, release the mouse - the copy action 
automatically connects to the encode action.

Figure 8. Release the mouse to auto-connect actions.

Working with 
Workflows

Lets take a moment to learn some techniques for working with workflows, 
before we continue to make changes.

Some workflows – like Simple Transcode – have only a few actions in 
them; others may have dozens of actions. Sometimes you’re working on 
the big picture of a workflow – laying out actions and connecting them 
together. Other times, you’re working on action details – configuring the 
details of a transcode task, for example. 

In each case, you may want to zoom in or out, or scroll around – or center 
– the work area, to help you focus directly on the work you’re performing 
at the moment.
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Zooming In and Out 
on a Workflow

The zoom slider bar at the bottom left corner enables you to zoom in and 
out to suit your needs.

Figure 9. You can zoom in and out to display workflow details.

There are three ways to zoom in and out on a workflow:

 Drag the zoom slider bar at the bottom left of the workflow

 Repeatedly press Control-+/- (the plus and minus keys)

 Use the scroll wheel on your mouse while pressing the control key.

Moving the Workflow 
in the Design Space

A workflow with many actions may be larger than you can view effectively 
in your workspace, when viewed at the zoom level you’re currently using. 
To move the workflow around in the workspace, click anywhere on the 
workflow canvas itself (don’t click on an action). The cursor becomes a 
compass – now, you can drag the workflow in the appropriate direction.

Centering a Workflow To center a workflow in your workspace, right-click in the workspace and 
select Recenter Workflow from the context menu. Alternatively, you can 
press Control-R on the keyboard.

Before you continue, take a few moments to practice zooming, moving, 
and centering the workflow – you’ll use these features frequently, and 
becoming familiar with them now will make it easier to focus on the design 
process.

Setting up Actions Each actions performs a specific function - but each action must be set up 
(configured) to perform the task specifically the way you want for a given 
workflow. (Graphics in the section have been shortened in the interest of 
improving readability.)

Each action displays a yellow I (for inspector) icon in the top left corner, 
indicating that it needs to be configured.

11. Click on the I icon to open the action inspector for watch actions, 
which allows you to set up the action the way you want.

Use the zoom slider bar to 
zoom your workflow in and 
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Vantage Designer displays the first panel of the inspector:

Figure 10. Select the type of file you want to poll for.

Vantage intelligently handles several complex media types such as Avid 
reference movies, or P2 camera files.

12. Select Any Media to simply watch for a single media file - click Next to 
continue. 
Vantage displays the next panel in the inspector:

Figure 11. Select the file system you want to poll.

13. Note the comprehensive list of file systems that Vantage can access. 
Select Windows as the file system for this watch action, and click Next 

File formats supported 
by Vantage - those in 
gray are not licensed.

File systems supported 
by Vantage - those in 
gray are not licensed.
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to continue. 
Vantage displays the next panel:

Figure 12. Enter the fully-qualified path to the hot folder.

If you installed Vantage on a single machine, you can specify a local 
folder (for example, C:\vantagetouronein). In a multi-server array (a 
distributed Vantage domain) however, this should be a shared Windows 
network folder (for example, \\<machinename>\vantagetouronein). 

14. In either case, create a hot folder for this workflow and then click 
Browse to navigate and select the fully-qualified path in this field. Or, 
enter it manually. 

15. Click Next to continue.
Vantage displays the next panel:

Figure 13. Watch action’s polling details.

Take a moment to review the comprehensive settings related to directory 
polling. Place your mouse cursor over the settings to display tooltips 
which tell you the function of each setting. Also, you can click the M 

Click Browse to navigate 
to and select your hot 
folder.
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button in the top right of the Inspector to open documentation for this 
action.

16. Click Next and then Finish to complete configuration of the watch 
action.

Now that you’ve configured the action, notice that the inspector icon is 
hidden to let you know that it has been configured. Move your mouse 
back over the action - Vantage displays the inspector icon again. You can 
always click it to re-open the action inspector to review or change its 
settings. 

Vantage Folders 17. Open the copy action inspector. 
Here, you’ll configure the destination for the file that the encode action 
creates as it transcodes the incoming file to the new format.

Figure 14. Copy action inspector (prior to configuration).
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18. Click on the Browse (… (ellipses)) button to the right of the Destination 
field.
Vantage displays the Vantage Folder address book:

Figure 15. Vantage Folder Address Book.

Vantage Folders enable you to name and define specific destinations in 
the Vantage database, for use in other workflows, simply by using their 
name. This greatly simplifies directory referencing. 

19. Create a new Vantage folder - click the Add Folder toolbar icon (the 
new folder icon at far left):

Figure 16. Vantage Folder - Add New Folder dialog.

20. Enter the folder in the Name field: Default Folder.

21. Next, click Modify to specify the directory that this Vantage folder 
points to.
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22. Vantage folders can be on any supported file system; for this tour, 
choose Windows File System and click Browse to select a directory of 
your choice (for example, in Windows Explorer make a folder named 
C:\vantageout) for the output media file to be copied, and click OK.

23. Click Next to close the Folder Location Editor dialog. (You may have to 
click OK on the local folder warning dialog.)

24. Click OK to add this new Vantage folder to the domain and close the 
Add New Folder dialog.

25. Now, with the Vantage folder you just created selected, click Select to 
specify the folder as the destination for the copy action.

Figure 17. Copy action inspector - complete.

26. Finally, click Save to save these Copy action settings and close the 
inspector.

The Simple Transcode workflow now has three actions: watch action, 
encode action, and copy action, all of which have been configured. The 
watch action polls the hot folder for new media. The transcode action 
decodes and re-encodes the incoming media to QuickTime format using 
H264 and AAC codecs, and the copy action duplicates the file into the 
output folder as specified by the Vantage folder you selected.
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Activating 
Workflows

27. Lets activate the workflow now - click Activate at the bottom of the 
window.

Figure 18. Workflow Status tab.

The Vantage monitor service starts executing your workflow. Specifically, 
the monitor service starts running the watch action in your workflow, 
polling the hot folder you specified for new media to process. No job is 
started until a new file is identified and submitted.

Click Activate to release the workflow from editing, 
save it, and activate it to start the watch action.
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Monitoring your 
Workflow Status

When you activate this workflow, Designer displays the Monitor Status tab 
(see the top of the window) to display the status of the watch action:

Figure 19. Workflow Monitor Status tab.

Notice that the watch action states is listed as In Process, which indicates 
it has started executing, and it is polling for new files. When a new file is 
discovered, a job is created that executes the Simple Transcode 
workflow. 

Actions may also be in Waiting state - the state that the transaction enters 
while Vantage is determining which service should process it. A 
transaction remains in Waiting state until it is accepted by a service for 
processing.

You can also double-click the watch entry in the table to display more 
detailed information about the watch. You can confirm that is polling the 
directory that you specified, and that no new files are detected.

Figure 20. Workflow Monitor Status Details.

Submitting Jobs You can start a job for this workflow in one of two ways:
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 Place a media file in a hot folder that is being watched to submit a job 
automatically

 Click the Submit Job button (at the bottom of the window) and select 
the file to submit a job manually. Just follow the steps in each panel.

Take time now to use both methods to submit a file to start a job with this 
workflow.

We suggest that you use one of the sample wmv media files we provide, 
located at <InstallDrive>:\Program Files\Telestream\Vantage\Store\.

After you submit a job, click the Job Status tab to display the status of 
running jobs.

28. Click on the new job entry in the table, and observe each action 
change color as the entire job executes each task specified by the 
actions in the workflow. 

Figure 21. Activated actions display a green border

Workflows display specific border colors to identify their current state in 
this job:

 Yellow indicates the action hasn't started executing yet

 Green indicates the action is currently executing

 Blue indicates the action has completed without errors

 Red indicates the action has completed with errors.
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29. Move your mouse over actions in the Monitor Status panel to display 
the i (inspector) icon in the top left corner. Click the icon to display 
runtime information about the action in the Status/History window:

Figure 22. Status/History window displays action details.

30. Click on each succeeding status line in the Status/History window to 
display details about the action. Close this window when you’re done.

When all actions are outlined in blue, the job has completed successfully:

Figure 23. Completed actions display a blue border.

Playing your New 
File

Now, in Windows Explorer, navigate to the copy destination folder you set 
up in your workflow (for example, C:\vantageout). 

Double-click the new file which your workflow transcoded into QuickTime 
to play it!
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Deactivating 
Workflows

In the next tour, you’ll use a copy of this same workflow. You should 
deactivate this workflow so that you can use the same hot folder in the 
next workflow, without the Simple Transcode workflow ingesting new 
media you add to the hot folder. 

31. Select the Simple Transcode workflow in the workflows panel, and 
click Deactivate at the bottom of the window.

Figure 24. Select a workflow and click Deactivate to stop its watch.

If you want to edit the workflow again, click Edit at the bottom of the 
window. When you’re done editing a workflow, you should click Release it 
so that it can be edited or executed by others in the organization.

Conclusion Congratulations! You’ve just learned about the key features of Vantage 
Workflow Designer. Now you know how to create and activate a basic 
transcoding workflow. You’ve also learned how to submit media to a 
workflow, monitor its execution, and view the transcoded media file.

In the next tutorial, you will explore transcoding settings to transcode a 
media file into the format that you want.
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TOUR 2: TRANSCODING FILES USING 
SETTINGS YOU WANT

This hands-on tour takes about 30 minutes and introduces you to 
Vantage transcoding. 

Tour Overview This tour is designed to add to your workflow management and creation 
skills, and your first in-depth look at how effectively Vantage deals with 
the complexities of media transcoding. In this tour, you’ll learn about the 
following:

 Duplicating a Workflow

 Adding Branches to a Workflow

 Configuring the Transcode Action

Starting Workflow 
Designer

If you quit Workflow Designer after the last tour, start it again:

Double-click the Vantage Workflow Designer shortcut on your desktop or 
select start > Programs > Telestream > Vantage > Vantage Workflow 
Designer.

Duplicating a 
Workflow

In the Workflows panel (left), select the workflow you want to duplicate.

1. Open (click) the Vantage Tours category and select the Simple 
Transcode workflow by clicking on it.

Figure 25. Duplicating a workflow.
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2. Now, select Workflow > Duplicate Workflow (or right-click and select 
Duplicate Workflow). Vantage displays the Duplicate Workflow dialog:

Figure 26. Enter the name for the duplicate workflow.

3. Enter the name of the new workflow: Complex Transcode. Click OK to 
save the workflow with the new name and dismiss the dialog. Vantage 
automatically selects the new workflow, places it in edit mode and 
displays it in the Workflow Design tab.

Adding Branches 
to a Workflow

Now, lets add a second, pre-configured transcode to this new workflow in 
a manner that enables Vantage to encode two separate output files 
simultaneously, from a single workflow - by creating a branch, with 
parallel actions. Creating branches for multiple, parallel encoding is an 
important part of Vantage scalability and high-volume transcoding.

Enter the name of the new workflow 
you want to create.
74-0236-00
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4. Open the transcode action group on the action toolbar.

Figure 27. Click the Encode action to select a preset action.

5. Click on the Encode action, and select the Mobile > 3GPP 300KB 
H.264 with AAC preset to add it to the workflow.

6. Next, drag from the out connect pin on the right side of the watch 
action to the in connect pin (left side) to connect the new Encode into 
the workflow - this creates a new branch in the workflow.

Note: This encode action is the only action in this branch - you haven’t 
added a copy action. So, if you executed this workflow now, where would 
the new 3GPP file be saved? The short answer: it is written to a default 
store - a pre-determined Vantage directory created for saving files when 
there is no explicit directory specified - more on stores later.

When a workflow has multiple branches, actions in those branches can 
execute simultaneously. In this case, once a file has been discovered and 
a job has been created (or a job has been manually submitted), both 
encodes will execute at approximately the same time, resulting in faster 
throughput.

Activating the 
Workflow and 
Submitting a Job

7. Now, lets activate this workflow and submit another job. If you don’t 
remember how to submit a job, refer to Tour 1, Submitting Jobs.

As the job executes, notice in the Job Status window the simultaneous 
execution of both transcode actions.
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Configuring the 
Transcode Action

Now, let’s look at the original QuickTime transcode action you added in 
Tour 1 in more detail, and learn how to change encoder settings.

8. Click Edit to deactivate the workflow and enter editing mode.

9. Next, mouse over the QuickTime encode action you created in tour 1 
to display the inspector icon (the i icon at the upper left corner) of the 
encode action and click it to display the encode action inspector:

Figure 28. Encode action inspector.

10. Click the Encoder dropdown menu to display the list of encoders you 
can assign to this action.

11. To the right of the video stream, click the Video Codec dropdown 
menu to display the video codecs that are available with this encoder.

12. To the right of the audio stream, click the Audio Codec dropdown 
menu to display the audio codecs that are available with this encoder.

13. At the far right of the video and audio streams, click the Container 
dropdown menu to display the containers that are available with this 
encoder.

Note: As you click on the video codec, audio codec, and container 
buttons to select them, configuration details display in the configuration 
panel at the bottom of the window. For example, the Video Codec 
configuration panel enables you to set frame width, height, and bitrate 
for the video in the QuickTime file.

When you select a stream (by clicking the audio or video stream buttons, 
far left), you can also add processing filters.

Enco
displa
enco
doma

Video
codec

Audio
codec

Conta
and m

Stream
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14. Select the video stream button in the toolbar and click on the Video 
Filter dropdown menu to display a list of video filters.

Figure 29. Encode action inspector.

15. Select the Contrast filter - Workflow Designer adds it to the video 
stream.

Figure 30. Adding filters to video and audio streams.

16. These filters are applied during a transcode, and provide you a great 
deal of control over how the transcode functions.
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17. Next, click on the Video Codec at the far right to display the codec 
settings at the bottom of the window:

Figure 31. Select a component of media to view details.

18. Open Frame Size/Frame Rate and change the frame size to 640x360.

19. Finally, click the Encoder dropdown menu at the top to display the 
encoders that you can select. When configuring a given encoder, you 
can select it and configure it from scratch, or you can select and use a 
pre-existing template for this encoder (which you did earlier when you 
added the 3GPP encode action).

20. Click Cancel to close the inspector without making any changes to the 
encoder.

Note: Encode actions name output files they create using the same root 
name as the original media file’s name, with an appropriate suffix, based 
on the encoder. For example, a new QuickTime movie from 
FlipDemo.MSS is named FlipDemo.mov.

Conclusion You’ve just learned how to duplicate an existing workflow, how Vantage 
performs multiple simultaneous encodes, and you’ve been introduced to 
the basics of configuring encode actions to perform encoding tasks the 
way you want them to.
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TOUR 3: USING BINDERS IN WORKFLOWS

This hands-on tour takes about 30 minutes and introduces you to the 
concept of a binder in Vantage and how they enable you to easily track 
and manage multiple files during a workflow, simplifying workflow design.

Tour Overview In this tour, we explore a key and powerful feature in Vantage - binders. 
Binders enable you to simplify complex workflows, and organize all of the 
assets for a given version of media in a centrally-accessible manner. In 
this tour, you’ll learn the following:

 Introduction to Binders

 File Mode vs. Binder Mode

 Nicknames

 Adding a Delete Action

 Tracking Nicknames in a Workflow

 Attachment Files and the Associate Action

Introduction to 
Binders

A binder is a collection of media files, attachment files, metadata tracks, 
and metadata labels. Binders are not an actual physical location; rather, 
they are a collection of references to files and labels in the database. 
Binders provide Vantage with the mechanism for tracking multiple assets 
as a workflow executes. This allows you to design very complicated 
workflows – that can deal with dozens of files simultaneously – and 
separates your workflow design from the underlying files themselves.

File Mode vs. 
Binder Mode

By default, Vantage initially starts in file mode, a simplified mode 
designed for transcoding workflows. In file mode, Vantage automatically 
assumes that each action operates upon the media file created (or 
otherwise processed) by the previous action. This makes workflow design 
easier, particularly for simple transcoding workflows.

However, many actions are not suitable for - or available - in file mode. 
For example, the delete action is not available – it requires that you 
identify a specific file - how would you convey to the action which file to 
delete? Or, if you deleted the only file in the workflow, what file would 
following actions use?

Further, although file mode allows you to create workflow branches, it 
doesn’t allow you to merge the branches. That’s because, in file mode, 
each line represents the flow of a file through the workflow - thus, when 
the two branches merge, which file would the merged actions operate on?

While the file-based workflow concept is straight-forward and enables fast 
and easy workflow design, file-based workflow design has some inherent 
limitations.

To overcome these limitations, Vantage introduces binder mode. In binder 
mode, workflow lines represent do not represent the movement of a file - 
they only represent the order of the execution of actions. This key 
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difference separates the files being processed from the design of the 
workflow itself; instead, the files are tracked in a binder as the workflow 
executes. As the workflow executes it utilizes the files in the binder, but 
the files do not flow through the workflow along the connecting lines.

Now, lets get some hands-on experience with binders.

1. If you quit Workflow Designer after the last tour, start it again.

2. Before you switch Workflow Designer to binder mode, take a minute to 
open the action groups in the actions toolbar and note those actions 
that are deactivated and display dark gray. These are the actions that 
are not accessible in file mode workflows.

3. Now, switch to binder mode - select Options > Application Mode> 
Binder. (You can also return to file mode: select Options > Application 
Mode> File.) In binder mode, all actions are available for use in your 
workflows.

Note: If you edit a workflow you created in file mode when Workflow 
Designer is in binder mode, the workflow is converted to a binder mode 
workflow and you can’t convert it back.

Nicknames Another key, time-saving feature of Vantage that is the notion of 
nicknames. A nickname in Vantage is a convenient means of referencing 
a file within a binder. In Vantage, all files are referenced by nickname as 
you design and configure the workflow. In binder mode, these nicknames 
display on each action.

Nicknames do not affect the actual file name, rather they are simply a way 
to tell each action in a workflow which file (referenced by the nickname) it 
should be using. The use of nicknames makes workflow design much 
easier – Vantage automatically tracks the physical location of the actual 
files – allowing you to simply refer to files by nickname as you design the 
workflow.

Vantage generates nicknames automatically or you can assign your own 
nicknames to be more meaningful. Nicknames are stored in the database, 
and they can be re-used over and over again in multiple workflows - 
they’re only attached to files during the execution of the workflow.

Virtually every action in Vantage involving a file uses a nickname to 
reference it.

4. Select the Simple Transcode workflow, and open the watch action 
Inspector.

5. Click Next three times to step through the inspector panels until you 
display the Configure Settings panel.

Note that the topmost item in this panel is a dropdown menu, displaying 
the nickname of the file, which defaults to Original. This setting causes 
the watch action to provide each new file that it discovers the nickname 
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Original in each job it submits, so that downstream actions can reference 
the file just by using the nickname Original. 

Figure 32. Watch action’s polling details.

6. Now, close the watch action and open the encode action. Note that the 
input media file nickname (the dropdown directly below Encoder) is 
also referencing the Original input file.

Note: For some complex media types – such as Omneon reference files 
or P2 camera files – a media file is actually a collection of files, all of 
which are necessary to make the media work. In this case, the nickname 
refers to the entire collection of media files; Vantage tracks the 
underlying video and audio files automatically.

Adding a Delete 
Action

One of the important actions that is only available in binder mode is the 
delete action. The delete action allows you to delete a file as part of a 
workflow. Let’s add it to a workflow to delete the original file after 
encoding is complete. (Remember, editing this workflow in binder mode 
converts it to a binder mode workflow.)

7. Select the Complex Transcode workflow and duplicate it as Complex 
Transcode Tour 3.

8. In Complex Transcode Tour 3, open the transport action group, and 
click and drag a delete action into the workflow. Notice that there are 
no nicknames displayed on this action.

Note: If the delete action is deactivated, you’re still in file mode - switch 
to binder mode: Options > Application Mode> Binder.

Nickname assigned to 
this file. You can choose 
one from the dropdown, 
or enter a new one.
August 2010



Chapter 1 Getting Started
Vantage Management Console and System Administrator User’s Guide

29
9. Now, connect the delete action to the copy action on the top encode 
action branch. 

Notice that the nicknames now display on this action. The list on the left 
are files available before execution; the list on the right are files available 
after execution. (After configuration, the files used in this action are 
highlighted.)

Figure 33. File nicknames display on the face of an action.

10. Now, open the delete action inspector (remember to click the yellow I 
icon in the top left corner). 

Figure 34. Delete action inspector lists files by nickname.

The delete action accepts one parameter: The nickname of the file that 
you want to delete. This delete action displays the nicknames of all files in 
the workflow - Original (from watch) and Version0, and Version1 (from 
both encodes). 

11. Select Original (which identifies the ingested file) and click Save to 
close the inspector.

Now - Vantage highlights the other encode action’s Original nickname in 
red, indicating an error - this file has been deleted. By using nicknames, 
Vantage can discover many workflow design issues automatically – in this 
case, you’re attempting to delete a file while it is simultaneously being 
transcoded by a peer encode action in the other branch!

Nicknames of files 
in this workflow 
before execution 
of this action.

Nicknames of files 
in this workflow 
after execution of 
this action.
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This issue is easily resolved by connecting the second encode action to 
the copy action to merge the branches, as shown following, with the steps 
complete:

Figure 35. Merged branches synchronize actions.

12. Click and drag from the out pin of the bottom encode to the in pin of 
the copy action.

When the workflow branches are merged, the workflow is now valid and 
the encode actions are synchronized - and in this case, the workflow 
waits for all upstream workflow branches to complete before executing 
the first step in the merged branch. When the branches are merged, the 
copy and deletes action won’t execute until both encode actions have 
completed.

Tracking 
Nicknames in a 
Workflow

Now, to see automatic file tracking in action, lets change a nickname.

13. Open the top (3GP Advanced) encode action inspector (you know that 
it is creating a new version of a media file). 

14. You can provide your own nickname for each media file you use or 
create in a workflow - for example, select Version1 in the Output 
Media File Nickname field and enter MyNewMediaFile and close the 
inspector.

15. Of course, downstream actions (such as the copy) need to be updated 
if they used the nickname you just deleted (Version0) - open the 
inspector and select MyNewMediaFile as the new nickname to copy.
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In binder mode, you also have a more detailed view of what is going on 
inside each action.

Figure 36. Nicknames before and after execution.

Looking at the copy action, you can see which nicknames are available 
before the action executes on the left, and which nicknames are available 
after the action executes on the right. Further, Vantage highlights the 
nicknames that are used – and created – by an action.

Attachment Files 
and the Associate 
Action

Another difference in binder mode is support for non-media files, called 
attachments. An attachment file might be an XML file, an SCC caption 
file, an STL subtitle file, a PDF, or any other type of file which is not 
actually media.

A binder may contain more than one media file; it may also contain more 
than one attachment file. This capability allows you to copy and move not 
only the media, but any supporting files that are necessary in the 
workflow.

Vantage also allows you to watch hot folders for attachment files as well 
as media files. 

Open the watch action inspector, and note that you can determine 
whether to watch for a media or attachment file (select Watch for options 
at the top of the panel).

This feature is useful in several situations. For example, suppose that you 
have a set of media files and you are receiving SCC caption files that 
need to be matched to those files, and applied during a transcode. You 
can set up a watch action to wait for incoming SCC files; but how will you 
apply them to media?

The answer lies in the associate action, which allows you to add files to a 
binder midway through a workflow. It accomplishes this by matching the 
filename of an existing binder file, to discover new files that will be added. 
For example, in this workflow, the filename of the SCC file can be used 
match with the appropriate media file; now both files are in the binder and 
they can be used in the workflow.

Conclusion In this tour, you learned how to enable binder mode, and you learned 
about file nicknames. You also learned how to manage multiple assets in 
a workflow, and how to troubleshoot for errors.
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TOUR 4: USING VARIABLES IN 
WORKFLOWS

This hands-on tour takes about 30 minutes and introduces you to the 
concept of variables in Vantage and provides you a first look at the 
Vantage Management Console.

Tour Overview This tour discusses the role that variables play in Vantage workflows: 
passing important job information between actions, controlling execution 
flow, action priority, and controlling job routing. 

In this tour, you’ll learn the following:

 Introduction to Variables

 Starting Vantage Management Console

 Creating and Managing Variables

 Using the Priority Variable

 Setting Variable Values in a Workflow

 Using Variables in the Workflow

Introduction to 
Variables

Variables are temporary job metadata; it is information that only lasts as 
long as the job. A variable is simply a name, a type, and a value – for 
example, a number named Lines of Black at Top, set to 50.

Variables can be used in several ways in Vantage:

- Variables allow information to be passed between actions in a workflow

- Variables can be used for job routing to specialized hardware

- Variables can be used for decision-making

- Variables can be used to determine the priority of a particular action

In this tour, you’ll learn how to manage and publish variables. In 
subsequent tours you’ll also learn how to use variables for decision-
making and job routing.

Starting Vantage 
Management 
Console

Variables are managed in the Vantage Domain via the Vantage 
Management Console. 

To start the console, double-click the Vantage Management Console 
shortcut on your desktop. 

Figure 37. Vantage Management Console desktop shortcut
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Or, select start > Programs > Telestream > Vantage > Vantage 
Management Console.

Recall that the Vantage Management Console (usually referred to as just 
console) is the program you use to configure and administer your 
Vantage domain - including Vantage services, licenses, workflow design 
items, and the workflows themselves.

1. Double-click the Vantage Management Console now to launch it.

2. If you haven’t previously launched the console, you’ll be prompted to 
select a Vantage domain. Select your Vantage domain to continue.

Creating and 
Managing 
Variables

To create and manage variables in a domain, you create variable 
templates. You use these templates to implement variables in your 
workflows, and also for use in Vantage services.

3. Select Workflow Design Items > Variables to display the Variables 
panel:

Figure 38. Variables panel in the Management Console.

The Variables panel displays a list of pre-set variable templates that are 
included with Vantage for use in the domain. You can use these variable 
templates in workflows as-is, or you can select a variable template, 
change its name, type, and change its default value. 

4. For example, select the Curtained template to displays its details at 
the bottom of the panel. The variable template is configured in edit 
fields to allow you to change the properties of the template.

You can also add your own variable templates. Let’s add one now. 

Variable Template Toolbar:
New | Delete | Save | Duplicate | Import | 
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5. Click the Create a New Variable icon in the toolbar (far left icon).

Figure 39. Variable template details.

6. In the details panel, enter the name File Creation Date, set the 
value type to Date, and leave the default value unchanged.

7. Click Save the Save icon (disk) to save your variable template.

Note: There is nothing special about the name File Creation Date – you 
can create variable templates with any name. However, in this workflow, 
we will use this specific variable to store the creation date of the file.
In addition, you can also duplicate an existing variable template and just 
update it to meet your needs. 

Using the Priority 
Variable

There is one special variable that cannot be edited – Priority. This variable 
has special meaning in Vantage, because it sets the priority of any 
actions that receive it when determining job load balancing.

However, aside from this special meaning, Priority acts like any other 
variable. Its value can be set just like other variables, and it can be used 
for all the same purposes. 

Setting Variable 
Values in a 
Workflow

The power of variables is that their value can change during a workflow. 
There are several ways that this can happen:

- As the result of an action executing. For example, analysis actions 
generally can publish their results as variables. Similarly, watch and 
associate actions can publish information about files that they detect, 
using variables.

- From external metadata. Specifically, the populate action can set 
variables based upon metadata label values found in external files.

- From Web Services. The Web Services notify action can receive the 
results of a web services call and make those results available as 
variables.

- As a pre-step to an action executing; any action can set any variable 
prior to execution.

- As a pre-step to a machine executing an action; any service on any 
machine can be configured to set a variable before executing an action.
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Let’s experiment with two of these. First, lets modify an encode action in 
the Complex Transcode workflow, so that Vantage processes it with a 
higher priority than the other.

8. Open Workflow Designer, and duplicate Complex Transcode Tour 3 
as Complex Transcode Tour 4.

Figure 40. Adding variables to a workflow.

9. Right-click the 3GPP encode action (top branch) and select Add 
Variables from the context menu to display the Add Variables dialog.

Figure 41. Right-click and select Add Variables.
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10. Next, click the Add Variable(s) icon in the toolbar to display the Select 
Variables dialog:

Figure 42. Select variable templates to add to this action.

11. Scroll through the list (or press the first letter of the variable - in this 
case P) and select the Priority variable template - click OK to add it to 
this action.

Now, the Priority variable is attached to the workflow and its value will be 
set to 5 prior to the encode action executing. You can change the value of 
the variable at the bottom of the panel – higher numbers indicate higher 
priority, lower numbers indicate lower priority. 

Figure 43. Adding variables (and setting values) to encode.

12. Enter a large number (for example, 100) and click OK to make this 
variable setting permanent.

Next, let’s configure the watch action to set the value of the File Creation 
Date variable that you created earlier, each time it picks up a file and 
submits a job.
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13. Open the watch action inspector, and click Next repeatedly to display 
the configuration panel:

Figure 44. Adding variables (and setting values) to watch.

14. Under Generate Variables, check the File Timestamp checkbox.

15. Next, use the drop-down to select File Creation Date, the variable that 
you created in the Management Console earlier in the tour.

Now, your watch action will publish the timestamp of any file that it finds, 
into the variable File Creation Date, for use in this workflow. You’ll use this 
variable in the next tour.

Using Variables in 
the Workflow

Variables are generally available to any action downstream from where 
they were set. In the case of File Creation Date, that variable’s value is 
available to all subsequent actions. In contrast, setting Priority on one 
encode action does not affect Priority on the other - because these are 
two different variables with the same name in two different branches… 
but it does affect the downstream actions from those encode actions.

In cases where workflow branches merge, variables are passed from the 
branch which actually completes last. Because this is indeterminate (from 
the perspective of workflow actions), it is recommended that merged 
branches explicitly set variables that are important. In this case, you could 
set Priority on the merge action; this would ensure that no matter which 
upstream branch completed first, it would work.

If a variable is not set explicitly in a workflow, but is used by an action in 
the workflow, then the variable’s default value is used. For example, in the 
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above workflow, we set Priority to 100 for one of the encode actions; the 
other would use the default value of 5.

Conclusion In this tour, you learned about managing and creating variables, as well 
as how to set variable values in a workflow. In the next two tours, you’ll 
learn about how to use variables for decision-making, and how to use 
them to pass information between actions in a workflow.
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TOUR 5: DECISION MAKING IN 
WORKFLOWS

This hands-on tour takes about 30 minutes and introduces you to the 
concept of decision-making in Vantage and you use variables to make 
decisions.

Note: To execute workflows you create in this tour, you’ll need a license 
- certain features (the decide action, for example) won’t execute without 
one. For a demo license, contact sales@telestream.net.

Tour Overview In this tour, you’ll learn the following:

 Action States

 The Decide Action

 Processing New Files Example

 Filtering Old Files Example

If you quit Workflow Designer after the last tour, be sure to start it again.

Action States After most actions execute, they set one of three action states to indicate 
the result of the execution: Pass, Ignore, and Fail. This state is 
automatically passed to the next action or actions (in the case of a 
branch) in the workflow; these actions in turn may determine whether or 
not to execute based upon the incoming state. Action states enable 
decision-making - causing entire branches of the workflow to not execute.

To understand how to use action states, its important to understand their 
precedence, whether an action receives states from one or multiple 
incoming actions (a merge of multiple branches):

- If at least one incoming state is Fail, regardless of other incoming states, 
the action inherits Fail and must pass it on - Fail has precedence over all 
action states. Most actions will not execute if they inherit Fail. If one action 
fails, the entire job fails.

- If there is no Fail state, but at least one Pass state, then the action 
inherits Pass - which has precedence over Ignore.

- If all incoming states are Ignore, the action inherits Ignore. Ignore has 
lowest precedence of the three states.

Generally speaking, actions only execute if (1) none of their predecessors 
set the Fail state, and (2) at least one of the predecessors set the Pass 
state. 

Similarly, if an action sets Ignore, the next action will also likely not 
execute. Most actions, excluding watch and associate, can be configured 
to perform on certain states - this allows workflows to send an email for 
example, if they detect a failure.

Note: Actions can also be configured to execute upon receipt of Fail or 
Ignore– for example, to send an email when a failure is detected. To 
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configure an action’s execution based on the incoming action state, 
right-click and select Perform On.

The Decide Action The Decide action analyzes incoming variables and sets the action state 
based upon the results of its analysis. Decide effectively acts as a 
gatekeeper to a branch in a workflow, determining whether the actions 
that comprise that branch should execute (Pass), not execute (Ignore), or 
report a failure (Fail).

Because variables are set at run-time, decide allows you to set this state 
at run-time and may behave differently for every job through a workflow. 
This action is a powerful action allowing you to build complex decision-
making into a workflow.

Note that if you want to have multiple branches in a workflow, and only 
execute one or some of them for each job, then you’ll need multiple 
decides – one acting as a gatekeeper for each branch in the workflow.

Processing New 
Files Example

Let’s look at an example.

1. Open the Complex Transcode Tour 4 workflow and rename it to 
Complex Transcode Tour 5. We’ll update this workflow to only process 
new files that are in the hot folder. 

Recall that in Tour 4, the watch action was configured to publish a 
variable named File Creation Date. We’ll use this variable to only process 
files created after January 1st, 2010.

2. In the actions toolbar, open the Common category and drag a decide 
action onto the workflow.
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3. Next, modify the workflow so that decide follows watch, and all 
remaining actions follow decide (shown complete):

Figure 45. Rearranging actions in a workflow.

4. To break action connections, roll over the connector between them 
and click the red X icon. In this case, you’ll have to delete the 
connectors between the watch and both encoder actions. Then, 
reconnect the actions the way you want them to execute.

5. Next, open the decide inspector. 

Decide is designed perform evaluations upon variables, and set a state if 
they meet all the conditions that you specify. 

6. In the top left, click Select Variables and add the File Creation Date 
variable. Next, select the > (Greater) operator and set the test value to 
January 1, 2010, 12:00:00 AM. Verify that the state selection is Pass – 
meaning that if the date is later than January 1st, this action will emit a 
Pass – and that the Otherwise state is Ignore. Click Save to save the 
workflow.

Now - because actions by default operate only when the incoming action 
state is Pass, your workflow will process files created after January 1st, 
but will not process files created earlier than that. 

Filtering Old Files 
Example

But what if you wanted to simply delete old files?
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Let’s modify the workflow to delete old files. To do that, you’ll create a 
new branch off of watch, with a decide and delete action (shown below, 
complete).

Figure 46. Rearranging actions in a workflow.

7. Add the decide action, connected to the watch on a separate branch. 

8. Now, open the decide action, and configure similarly to the previous 
one - add the File Creation Date variable, select the reverse operator 
<= (Less Than or Equal), and set the date to January 1, 2010 AM. If 
this is true, Pass is emitted; if false, Ignore is emitted.

9. After the decide, add a delete action and configure it to delete the 
Original file. It executes by default only on Pass states.

This workflow now has two branches controlled by decide actions – one 
will pass only new files, the other will pass only old files. Because of the 
way we configured the Decide actions, every file will execute only one 
branch in this workflow.

Conclusion In this tour, you’ve learned how to assign values to variables, to test those 
values, set action states, and use the decide action to make run-time 
decisions - all features designed to enable you to add control to your 
workflows, based on information you’ve gleaned from your input file.
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TOUR 6: DYNAMIC PARAMETERS

This hands-on tour takes about 15 minutes and introduces you to the 
concept of dynamic parameters in Vantage, and how they can be used to 
pass information between steps in a workflow.

Note: To execute workflows you create in this tour, you’ll need a license 
- certain features (the decide action, for example) won’t execute without 
one. For a demo license, contact sales@telestream.net.

Tour Overview In this tour, you’ll learn the following:

 Parameter Binding

 Cropping out Curtains

Parameter Binding Thus far, when we have configured our actions in a workflow, parameters 
have been set at a fixed value. For example, the frame size of a 
transcode output is 320x240. Obviously, by using fixed values the action 
performs the task the same way each time - creating an output file that is 
320x240 - every time this action executes.

How would workflow processing improve, if we could change these 
settings and parameters job-by-job, on the basis of the media being 
processed?

Vantage supports this capability to dynamically change the value of 
parameters and settings by binding parameters to variables. Recall that 
variables are metadata that is only known at run-time, and this metadata 
may be different for every single file. In Vantage workflows, you can 
configure almost any parameter, in almost any action, to use a variable 
(and its current value) as its input.

Cropping out 
Curtains

Let's build a real-world example. In this example, we know that some of 
our content has black on the left and right - curtains - that we want to crop. 
However, the amount of black is likely to be slightly different for every file 
being processed in Vantage. Instead of creating many workflows to deal 
with each situation - and manually measuring the black before 
processing, we'll build a workflow to crop the curtains automatically, as 
appropriate for each incoming media file, by combining an examine 
actions with a transcode with filters implemented.

1. Open the Complex Transcode Tour 4 workflow again, and rename it to 
Complex Transcode Tour 6. 

2. Using Complex Transcode Tour 6, open the Analysis group and drag 
an examine action out - connect it between watch and the top 
(QuickTime H.264/AAC) transcode action. (Remember to use Control 
to suspend auto-arrange to make it easier).

3. Open the examine inspector and click the Analyzer dropdown menu - 
select Curtain Detection. Designer displays the configuration setting 
for this analysis tool.
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4. Open Generate Variables and configure this action to publish two 
variables (by checking them): Crop Left (select the Curtained Left 
Pixels variable) and Crop Right (select Curtained Right Pixels). 

Note: Vantage provides many predefined variables for use in your 
actions. While this is convenient, you’re certainly free - and often will 
need to - create your own variables - they behave just like the ones 
Vantage provides.

5. Under Input Media File Nickname, select Original as the file to 
analyze. 

6. Click Save to update the action and close the inspector.

7. Next, open the inspector of the transcode action immediately after 
examine.

8. Click on the Video Stream button, then click the triangle in the Video 
Filter button (2nd from the right) to display the video filters you can 
use. Add a Crop video filter to the transcode. 

9. Select the Crop filter to display its parameters at the bottom of the 
window.

10. On the Left value, click the bind (green with ellipses) button to bind the 
Left parameter to the Curtained Left Pixels variable. 

11. Perform these steps to do the same for the Right parameter and the 
Curtained Right Pixels variable.

12. Click Save when you’re done. 

You've now created a dynamic transcode, which will automatically adjust 
crop settings based upon incoming curtain data from the curtain detection 
examine step. Every media file that is processed will have its own, custom 
transcode setting appropriate for that file!

Take a moment to explore the rest of the transcode settings in this 
inspector, and notice the bind buttons on many parameters. You’ll find the 
bind button in other actions as well - for example, the Web Service 
notification action allows you to send variables to external Web Services, 
and the Email message action allows you to include variables as part of 
an email.

13. If you have curtained material, submit a job for processing and view 
the results.

Conclusion In this tour, you learned how to create dynamic parameters that use 
variables as their inputs. This feature enables you to create powerful, 
dynamic workflows that adaptively change what they do based upon the 
metrics of the media being processed.
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 C H A P T E R  2

U s i n g  W o r k f l o w
D e s i g n e r
Vantage Workflow Designer is a multi-user application for creating and 
managing workflows, and submitting and monitoring Vantage media 
processing jobs. 

This chapter provides information about how you use the major features 
of Vantage Workflow Designer.

Topics  Starting and Stopping Vantage Workflow Designer

 Changing the Vantage Domain

 Using the Workflow Designer’s Workspace

 Using the Workflows Panel

 Using the Workflow Design Tab

 Using the Monitor Status tab

 Using the Job Status Tab

STARTING AND STOPPING VANTAGE 
WORKFLOW DESIGNER

Starting Vantage 
Workflow Designer

To start Vantage Workflow Designer, double-click the Vantage Workflow 
Designer shortcut on your desktop.

Figure 47. Vantage Workflow Designer desktop shortcut

Or, select start > Programs > Telestream > Vantage > Vantage Workflow 
Designer.

Stopping Vantage 
Workflow Designer

To stop Vantage Workflow Designer, select File > Exit. You don’t need to 
save work you’ve accomplished, because all workflows, monitor status, 
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and job information is stored in the Vantage database and updated 
automatically as you make changes.

CHANGING THE VANTAGE DOMAIN

Vantage Workflow Designer connects to a single Vantage domain at a 
time, and enables you to use workflows in that domain.

In a multi-domain environment, you can connect to any domain you want, 
and use that domain’s workflows or check on jobs in that domain.

Vantage domains are by default, identified by the name of the computer 
on which the Vantage database resides. To determine the domain to 
which Vantage Workflow Designer is currently connected, note the name 
of the computer displayed in the title bar of the window.

To connect to another Vantage domain, select File > Change Vantage 
Domain or right-click in the workflows panel away from any icons and 
select Change Vantage Domain.

The Workflow Designer polls the network for domains, and displays the 
Change Vantage Domain panel:

Figure 48. Change Vantage Domain panel.

Select the domain you want to connect to, and click OK. When you 
change domains, Workflow Designer closes its connection to the current 
domain’s Vantage database and connects to the selected domain’s 
database, refreshing the list of its workflows.

Click the domain to 
connect to, and click 
August 2010



Chapter 2 Using Workflow Designer
Vantage Workflow Designer User’s Guide

47

ame/
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y menu
USING THE WORKFLOW DESIGNER’S 
WORKSPACE

Vantage Workflow Designer’s window enables you to create and edit 
workflows, activate and deactivate them, and monitor their status and 
review jobs in process and already processed.

Figure 49. The Workflow Designer window

Note: When editing in file mode, the action display options menu (bottom 
right) does not display, and nicknames and variables do not display on 
actions.

Printing Workflows Select File > Print Workflow to print the selected workflow using the 
current workflow settings. The workflow is scaled to fit on a single page 
(with landscape or portrait mode preset based on workflow shape), unless 
the workflow is sufficiently large to make it difficult to read when scaled to 
a single page. Then, Designer provides you the option of printing across 
multiple pages.

Workflows Panel All of the workflows stored in the Vantage database are displayed in the 
Workflows panel on the left. Workflows are organized alphabetically by 
category. For details on the workflows panel, see Using the Workflows 
Panel.

Workflows panel - displays all 
workflows in the database.

Workflow Design panel, Monitor Status 
panel, and Job Status panel.

Nickn
Variab
Displa
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Using the Workflow 
Details Panel

To display the selected workflow’s details panel, click once in the title bar. 
Vantage obscures the tabbed panels by displaying the details panel for 
the selected workflow:

Figure 50. The workflow details panel.

Click again to hide the details panel.

Name. Name of workflow.

Description. Description of workflow - displays in workflow tooltip.

Expiration. Check to expire jobs from this workflow after the specified 
elapsed time.

Hours. Select the number of hours before this workflow expires.

Bound Variables. Indicates which variables are being utilized by actions 
in this workflow. If an action parameter in the workflow binds to a variable, 
it displays here.

Workflow Design, 
Monitor, and Job 
Status Panels

Information about the selected workflow is displayed in three tabs: 

- Using the Workflow Design Tab

- Using the Monitor Status tab

- Using the Job Status Tab.

Using the Workflow 
Status Buttons

At the bottom of the details panel are status buttons that you use to 
control the status of the workflow, and to manually submit jobs:

Edit. Click to modify the selected workflow. If the workflow is currently 
active (the monitor action is running and the workflow can process jobs), 
Vantage will display a warning dialog that it is about to deactivate the 
workflow. Click OK to continue.

The Actions toolbar displays at the top of the panel when in design mode, 
so that you can add new actions to the workflow.

Click once to
workflow deta
again to disp
tabbed panel
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When you are editing a workflow, other Workflow Designer users can 
view the workflow, but cannot edit or activate it.

Release. When a workflow is in Edit mode, click Release to stop editing 
it. Released workflows can be activated, and can also be edited by 
others.

Activate. Click Activate on a deactivated workflow to start any monitor 
actions so that jobs can be submitted and processed by this workflow.

Deactivate. Click Deactivate to deactivate the workflow. New jobs cannot 
be submitted and media cannot be processed by the workflow in this 
state. Existing jobs using this workflow continue executing to completion.

Submit Job. When the workflow is active, click to display the Submit Job 
window. For details, see Submitting Jobs Manually in Workflow Designer.

USING THE WORKFLOWS PANEL

Use the Workflows panel to create workflow categories, and create 
workflows.

Figure 51. Workflows panel.

When you are editing a workflow in file mode (Options > Application 
Mode > File), you can only edit or create file-based workflows; in binder 
mode (Options > Application Mode > Binder), you can edit all workflows. 
(For details, see Building Workflows.)

Workflows Panel 
Context Menu

Right-click in the workflows panel to display the following context menus:

In the panel title or empty space: Use this context menu to change the 
Vantage domain, or to create a new workflow category or new workflow.

On a category: Use this context menu to create a new category, or delete 
or rename the target category.

Select a workflow to work on.

Open a category to display 
workflows in it.

Create categories to organize your workflows.
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CAUTION: When you delete a workflow category, all workflows in 
this category are permanently removed from the domain database.

On a workflow: Use this context menu to change the mode to edit or 
release, and activate or deactivate the target workflow. You can also 
rename, delete, move, or duplicate the target workflow, or submit a job if 
the workflow is active.

Creating a New 
Category

To create a workflow category (at least one is required before you can 
create a workflow), select File > Create New Category or right-click in the 
panel away from workflow objects, and select Create New Category. 
Name the category and click OK to create it.

Renaming a Category To rename a category, right-click the category and select Rename. 
Workflow Designer makes the text editable - change the name and press 
Enter to update the name.

Deleting a Category To delete a category and all of the workflows it contains, right-click the 
category and select Delete. Click OK to confirm that you want to delete 
the category and its workflows and transaction history.

CAUTION: When you delete a workflow, it is permanently removed 
from the domain database, along with all of its transaction history.

Creating a New 
Workflow

To create a new workflow, select File > Create New Workflow or right-
click in the panel away from workflow objects, and select Create New 
Workflow. Workflow Designer displays the Create New Workflow dialog:

Figure 52. Create New Workflow panel.

First, select the category where you want the new workflow saved, and 
then name the workflow and click OK to create it.

For complete workflow creation details, see Building Workflows.

Select the category where you want 
to save the workflow.

Enter the name of the new workflow 
and click OK.
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Renaming a Workflow To rename a workflow, right-click the workflow and select Rename. 
Workflow Designer makes the text editable - change the name and press 
Enter to update it.

Deleting a Workflow To delete a workflow, select it and select File > Delete Workflow or right-
click the workflow and select Delete Workflow. Click OK to confirm that 
you want to delete the workflow and all of its transaction history.

CAUTION: When you delete a workflow, it is permanently removed 
from the domain database, along with all of its transaction history.

Moving Workflows 
Between Categories

To move a workflow from one category to another, select File > Move 
Workflow or right-click on the workflow you want to move and select 
Move. Workflow Designer displays a Category dialog. Select the category 
you want to move the workflow to, and click OK.

Duplicating a 
Workflow

To duplicate a workflow, select File > Duplicate Workflow or right-click on 
the workflow and select Duplicate. Workflow Designer displays a 
Category dialog. Select the category you want to create the new workflow 
in, enter a name, and click OK.

USING THE WORKFLOW DESIGN TAB

Click the Workflow Design tab to view, create, and modify workflows.

Figure 53. Workflow details panel.

Note

You can also rename a workflow in the Workflow details panel. See 
Using the Workflow Details Panel for details.

Binder File Nicknames 
| Variables View

Actions toolbar - drag 
onto design area to 
add to workflow.

Zoom control.
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For details on creating and configuring workflows, see Creating 
Workflows.

Actions Toolbar At the top of the panel is the actions toolbar, organized by action type. 
Click the arrow to open each action type and display the set of actions in 
this group. 

You can display the actions toolbar in two ways: right-click in the tool bar 
and select actions and text, or only actions. 

To add an action to a workflow, click and drag the action onto the work 
area, then connect it to other actions to create a workflow. Or, copy and 
paste an existing action.

Showing and Hiding 
Grid Lines

Select View > Show Grid Lines (Control-g) or right-click and select Show 
Grid Lines to display horizontal and vertical grid lines. Select again to hide 
grid lines.

Detail View Detail view is only available when Designer is in binder mode. Select 
View > Detail View (Control-d) or right-click and select Detail View. In 
detail view, Workflow Designer displays the action name, icon, and 
editable description, plus binder file nicknames or it variables used in the 
workflow, depending on the binder file nickname/variable display setting 
(in the bottom right corner of the Workflow Design tab). 

Click again to display actions only as an icon.

Binder File Nickname 
| Variables View

When Designer is in binder mode, binder file nicknames, metadata labels, 
and variables associated with an action display on the action (in detailed 
view) for quick reference. 

Figure 54. Actions can display binder and file nicknames plus 
metadata labels, or variables.

Binder File Nickname 
View

In binder file nickname view, each action displays a list of file nicknames 
and metadata labels that are available to the action before it executes (on 
the left), and the nicknames and labels that are available downstream 
when the action completes (on the right). Content items change color 
based upon the validity of the current workflow. Highlighted nicknames 
have been utilized / created in this workflow. Nicknames displayed in red 
represent an error.

Input nicknames

Output nicknames
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Note: Nicknames and labels that are used or affected by the action are 
highlighted. Nicknames and labels also change color indicating whether 
or not the workflow is valid.

For example, if you configure an action to utilize nickname Copy7 
provided by an earlier action and then delete the action that created 
Copy7, then Copy7 displays in red on the now-invalidated action.

Variable View The variable view displays variables that are used to bind parameters in 
this action. 

Action Summary Each action has a summary - to display it, hover over the inspector icon. 

Figure 55. Action summary text

The summary displays the action type, description (editable), and a high 
level description of how the action is configured.

Moving the Workflow 
in the Design Space

A workflow with lots of actions may be larger than your workspace when 
viewed at the zoom level you’re using. To move the workflow around in 
the workspace, click anywhere on the design area (including an action). 
The cursor displays as a compass – now, drag the workflow in the 
appropriate direction.

Centering a Workflow To center a workflow in your workspace, right-click in the workspace and 
select Recenter Workflow (Control-r) or select View > Recenter diagram) 
to recenter the diagram on the work area.

Hover over the inspector icon 
to display the summary text.

Summary text displays the 
action description and high 
level configuration details.
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Zooming In and Out 
on a Workflow

The zoom slider bar at the bottom left corner enables you to zoom in and 
out to suit your needs.

Figure 56. Vantage Workflow Designer

To zoom in on a workflow choose one of these actions:

 Drag the zoom slider bar to the right

 Repeatedly press Control-+ (the Plus key)

To zoom out on a workflow choose one of these actions:

 Drag the zoom slider bar to the left

 Repeatedly press Control-- (the Minus key)

You can also use the scroll wheel on your mouse while pressing Control 
to zoom in and out on a workflow.

USING THE MONITOR STATUS TAB

Click the Monitor Status tab to review the status of active origin actions for 
the selected workflow.

Figure 57. Monitor Status displays all active origin actions.

Use the zoom slider bar to 
zoom your workflow in and 

Each row is an active origin action, indicating status and other details.

Monitor Status toolbar - Group | Delete | Details.
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If your workflow is deactivated, the table displays a history of previous 
activations. If your workflow is active, the table displays active origin 
actions.

Click any column to make it the primary column and sort it ascending or 
descending.

Toolbar Groups. Click to organize actions by group, based on the primary column 
- the one you have selected. Click again to turn grouping off.

Delete. Click to delete the selected row(s). Or, right-click on the row, and 
select Delete.

Status. Click to display the selected action’s details. Or, right-click and 
select View Status.

Figure 58. Complete monitor action status details

For an activation that has completed (Success | Ignore | Failure), this 
dialog displays the current status details for the activation. 
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If the action is still active (Queued | Paused | In Process | Waiting), this 
dialog displays with a progress bar and the path of the target directory, 
plus the last status.

Figure 59. Active monitor action status details.

Export. Click to export these details for transmission to Telestream 
Customer Service to aid in support.

Session Log. Select a Session item in the tree and click Session log to 
display the Session log window.

Figure 60. Session log.

The Session log displays session activity entries, if any. This information 
can be helpful when working on an issue with Telestream Customer 
Service.

Click Done to close the window.
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USING THE JOB STATUS TAB

Click the Job Status tab to review the all jobs in the database for the 
selected workflow and pause and resume jobs in progress.

Figure 61. Job Status displays all jobs for the selected workflow.

If your workflow is deactivated, the table displays the jobs that are still 
executing or which completed prior to deactivating the workflow.

Click any column to make it the primary column and sort it ascending or 
descending.

Actions display a color to indicate their state: 

 Yellow - the action is waiting to execute

 Green - the action is currently executing

 Blue - this action has executed, and completed normally

 Red - this action has failed or an upstream action failed

 Dark Gray - this action did not execute due to action state analysis.

 Light Gray - this action is paused.

Toolbar Groups. Click to organize the jobs by group, based on the primary 
column - the one you have selected. Click again to turn grouping off.

Each row is a job processed by the selected workflow, 
indicating status and other details.

Job Status toolbar - Group | Stop | Restart | Delete | Binder

Real-time view of transaction processing.
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Stop. When processing, click to halt processing on this job. When you 
stop a job in process, each action for that job is notified to stop its own 
transaction. When all actions have been stopped, the job is considered 
complete, in a failed state. 

Restart. If a job was stopped or it failed, it can be re-started and will 
continue processing where it stopped. Actions that fail are re-attempted.

Delete. Click to delete the selected job row(s). Or, right-click and select 
Delete.

Binder. Click to display the selected job’s details. Or, right-click and 
select View Content.

Figure 62. Monitor Status displays all origin transactions.

The Binder window displays information about all files in this job, 
organized by nickname, metadata labels and tracks, and attachments, 
each in its own tab.

Media Files Tab This tab displays a list of files, including the file’s path, nickname, and 
filename. To the right is a WMV player control, where you can preview the 
selected content provided that it is in WMV format. For other media, press 
Play to attempt to play the file in an external viewer such as QuickTime 
Player, if one is available for the selected file’s format.

Metadata Labels Tab This tab displays metadata labels in the binder, their parameters and 
values. You cannot edit values in this viewer.

Metadata Tracks Tab This tab displays metadata tracks that exist in the entire binder.

Attachments Tab This tab displays a list of attachment files, including each file’s path, 
nickname, and filename.

Click Done to close the Details window.
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Pausing and 
Resuming Transcode 
Actions

You can pause and resume transcode actions in a job in progress.

Figure 63. You can pause and resume actions.

To pause a transcode action, right-click on the action and select Pause 
from the context menu. To resume a paused action, right-click on the job 
and select Resume from the context menu.

Pause for Priority in 
Transcode Actions

Pause for Priority feature is an automatic feature of transcode actions.

If a given transcode service is saturated (that is, it is performing a number 
of jobs equal to the number of configured sessions); then normally, 
Vantage will queue up the incoming job and wait for a slot to become 
available. For example, a transcode service is configured to run 2 
simultaneous jobs; it receives three jobs (A, B and C); jobs A and B begin 
execution (the service was idle prior to this) and job C is queued until 
either job A or B completes (at which point C will execute).

Pause for Priority comes into play if job C has a higher priority than job A 
or B. When job C has a higher priority that job A, then job A is paused and 
job C begins processing immediately. When Job C or Job B completes; 
then job A (which was previously paused) returns to processing.
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SUBMITTING JOBS MANUALLY IN 
WORKFLOW DESIGNER

To submit a job directly to a workflow, select the workflow and click 
Submit Job.

Figure 64. Click Submit Job on the selected workflow.

Note: You can only submit jobs to active workflows.

Designer displays the Submit Job window:

Figure 65. Submit Job window - select the file system.
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Select the type of file system where the input file is stored and click Next.

Figure 66. Submit Job window - select the file.

Click Browse to navigate to the directory and select the file you want to 
submit, and click Next.

Figure 67. Submit Job window - submit the job.

Click Submit to submit the job for processing. 

When you have submitted the job, you can view its progress in the Job 
Status tab (Using the Job Status Tab).
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 C H A P T E R  3

C r e a t i n g  W o r k f l o w s
Use this to learn how to build workflows, and configure them.

Topics  Building Workflows

 Working with Actions

 Configuring Actions Using the Action Inspector

 Setting Conditional Action Execution

 Using Variables in Actions

 Action Details

BUILDING WORKFLOWS

Workflows in Vantage are created using the workspace in the workflow 
design tab (Using the Workflow Design Tab), by adding individual actions 
and connecting them together. A workflow can be a single action.

Figure 68. Workflow details panel.

Generally, you build a workflow in stages: first, conceptualize and design 
the workflow; next add actions; next, connect them together to control 
execution. Finally, configure each action.

Binder File | 
Variables View

Actions toolbar - drag 
onto design area to 
add to workflow.
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File and Binder 
Mode

Vantage supports two workflow design modes: File Mode and Binder 
Mode. To select a mode, select Options > Application Mode and choose 
either file or binder mode.

File mode is the simplest mode for designing Vantage workflows. In file 
mode, lines connecting actions can be viewed as the path that files take 
through a workflow. In file mode, nicknames are not required; if a new file 
is created, subsequent actions will operate on that new file automatically, 
without you specifying it.

Actions in file mode workflows can only operate on the files created by 
their predecessor actions in the same control flow. You cannot create 
workflows that have rendezvous connections, where actions in two 
control branches connect to a single action.

File mode has some action limitations due to the fact that it does not allow 
the use of nicknames. For example, a delete action cannot be used - it 
would simply delete the file in the workflow. To access the full range of 
functionality in Vantage, binder mode is recommended.

File workflows are ideal for simple, transcoding workflows. 

Binder mode is the preferred mode for designing Vantage workflows. In 
binder mode, workflows reference files by nickname and lines connecting 
actions only indicate the execution flow of those actions. Workflows may 
have branches that rendezvous (or merge) and all actions are available in 
binder mode.

By default, Designer operates in file mode. You can switch modes any 
time you want, but if you modify a file mode workflow, Vantages converts 
it to a binder workflow. When Workflow Designer is in file mode, you can 
only edit or create file workflows; in binder mode, you can only edit or 
create binder workflows.

Automatic Conversion 
from File to Binder 
Mode

When Workflow Designer is in file mode, binder mode workflows are 
displayed in gray and can not be opened. You can select and view file 
workflows in binder mode, but if you edit them in any way (for example, 
changing the action description or opening and progressing through the 
inspector and clicking OK rather than Cancel), Workflow Designer 
automatically (and silently) changes the workflow to a binder workflow.

Designing a 
Workflow

Before beginning the process of building a workflow, it is often helpful to 
have a solid understanding of what you want to accomplish, what actions 
(or steps) are necessary to perform the tasks, and where the media (and 
optionally, metadata and associated files) originates and where any new 
copies of media, metadata, and associated files should be stored.

Ideally, you should know in advance how you want to encode the media, 
what file operations you need to perform, what systems you need to 
interact with, and what metadata processing must be performed. Make 
certain the Vantage has read and write access to the necessary file 
systems.

Of course, if you don't have all this information at the start, Vantage will 
allow you to change your workflow later. And when you build a workflow 
that you like, features such as Vantage Folders and Action Templates will 
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allow you to save common file locations, or actions, for re-use in other 
workflows.

Adding Actions to 
your Workflow

To add actions to a workflow, you open the action categories in the 
Actions toolbar and drag the action onto the design area. Action 
categories are described in Action Types. 

You can also copy and paste actions in your workflow. Right-click and 
select Copy to put the action on the clipboard. Next, click on the design 
area, right-click and select Paste to place the copied action on the design 
area. Or, right-click on another action of the same type, and select Paste 
to configure the action identically with the copied action.

When you drag an action onto the design area, Vantage may 
automatically align it near where you dropped it. Until you connect an 
action to other actions, you can move it anywhere you want on the 
workarea. 

A valid workflow consists of at least two actions, which must be 
connected. A valid action must start with at least one origin action (watch 
or receive).

Note: An origin action is required as the first action in a workflow, even if 
you plan to manually submit jobs to this workflow.

Workflows must begin with at least one origin action (such as a Watch or 
Receive action). Actions may have more than one origin action, but each 
origin action will function independently of the others. Each origin action 
may have its own workflow branch with following actions that are unique 
to that origin.

Workflows are not required to end with a terminating action - an action 
without an output pin. The only terminating action is the forward action. 
This action does not have an output pin, so you can't perform any actions 
after a forward action in a workflow (but terminating actions are not 
required).

Generally, you should drag and drop actions in a pattern similar to the 
desired workflow, working from left to right. However, you can drag 
actions anywhere, and connect them as desired later.

Vantage will tidy up actions - moving them and organizing them by 
column. Once an action is connected, you can move it vertically (up or 
down) but it cannot be moved from its column. Alternatively, Vantage can 
also attempt to optimize the workflow, removing as many line crossings 
as possible. To remove line crossings right-click on the workflow canvas 
and select Remove Line Crossings.

Connecting 
Actions To Control 
Order of Execution

You connect actions together in a workflow to control the order of 
execution relative to other actions, and to control the flow of variables and 
either files or binders (depending on your workflow mode) from one 
action to another.

Actions can only be connected from an output pin (on the right side of the 
action) to an input pin (on the left side of the action), and control flows 
from output to input - from left to right.
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To connect actions, click and drag a line from the output pin of one action 
to the input pin of the action you want to execute next in the workflow, or 
vice-versa.

Tasks proceed action by action, from left to right: when a workflow 
executes, actions at the far left execute first, and actions following the 
lines execute next.

You can connect a single action to multiple succeeding actions, as shown 
following. When you do, none of the actions you connect can execute 
before the preceding action upon which they depend completes. In this 
example, three copy actions execute in tandem after the watch action 
completes. These three actions occur independently of each other, and 
their start time and completion time relative to each other is non-
determinant.

Figure 69. Three independent actions follow a common action.
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You can also connect multiple actions to a single succeeding action, as 
shown following. When you do, each of the actions you connect must 
execute before the succeeding common action can execute. 

Figure 70. Three independent actions precede a common action.

In this example, three copy actions must execute and complete before the 
Message action can execute.

Actions that are not connected do not execute - a single, disconnected 
action invalidates the workflow. However, you can create multiple groups 
of actions, provided that each group starts with an origin action. Each 
group operates independently of the other groups; effectively, this is like 
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having three independent workflows, each with its own origin(s), running 
in a single window. This is not generally recommended.

Figure 71. Three independent actions precede a common action.

In this example, three independent sets of actions execute in the 
workflow.

WORKING WITH ACTIONS

Some connections create an invalid workflow, and there are several 
operations you can perform on actions in your workflow. The following 
topics describe these operations.

Invalid Action 
Connections

Certain connections between actions are invalid:

- You cannot connect actions to themselves or to other groups of actions 
to form a recursive loop. 

- You cannot connect the input (left) pin to another input pin, or an output 
pin (right) to another output pin.

Removing Line 
Crossings

On occasion, you might connect two actions on rows in the layout that are 
more than one row apart - resulting in an unintended line crossing. To 
manually optimize the workflow layout, select View > Remove Line 
Crossings or right-click and select Remove Line Crossings in the context 
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menu. Workflow Designer reformats the workflow and optimizes the 
layout of the actions in a grid.

Re-ordering Actions To re-order actions vertically, drag one of the actions up or down in the 
design area to the location where you want it. Designer adjusts the other 
actions to accommodate the manual placement of the other action.

Disabling Auto-
Arrange

To temporarily disable auto-arranging of actions while you're adjusting 
actions in a workflow, hold the control key down as you move each 
action. Note that when the control key is depressed, the Auto Arrange 
advisor displays Auto Arrange Off in yellow. 

Figure 72. Suspend layout optimization with the control key.

When you release the control key, auto-arranges goes back into effect.

CONFIGURING ACTIONS USING THE 
ACTION INSPECTOR

Each action has an action inspector - a series of one or more 
configuration panels - to access it, either click the inspect icon (round 
yellow i icon) in the upper left corner or by right-click the action and select 
Configure.

Figure 73. Each action has an Inspector icon.

Until an action has been configured, the inspector icon displays yellow; an 
unconfigured action cannot be executed. When an action has been 

Designer auto-arranges actions 
workflow as you work.

Hold down the control key to 
temporarily disable auto-
arrange.

Unconfigured actions display 
their inspector icon in yellow.
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configured, the icon disappears unless you're hovering over the action. If 
you hover directly over the icon, a summary of the action will display. 

The panel or panels vary, depending on the action, and the configuration 
choices you make. For example, to configure a copy action, you choose 
the source and copied file, and a destination - all in one panel:

Figure 74. Typical action inspector.

Conversely, the inspector for a watch action typically consists of about 7 
or more panels, depending on the file system you configure it to monitor.

When you’re viewing an inspector of an action in a workflow that is 
activated or someone else is editing it, the term Read Only displays in the 
inspector’s title bar. Also, if you have changed the configuration, an 
asterisk (*) displays immediately after the action name: for example, 
Watch *.

Detailed help is available on each panel in the inspector: Click the M icon 
to display its man page or click the ? icon to display the Workflow 
Designer User’s Guide.

Creating an Action 
Template

Vantage ships with several default encode and watch action templates. 
To make your own action templates, select Create Template to make a 
copy of the selected action so that it can be re-used in other workflows. 
The action template can be selected by clicking on the parent. 

Figure 75. Create Template window.

Grouping allows you to organize your action templates. If you want more 
than one level of grouping, separate each group with a vertical bar (|) - for 
example, Broadcast Servers | Grass Valley. The description of the action 
displays as the name of the action template.
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SETTING CONDITIONAL ACTION 
EXECUTION

You can configure each action to only execute when an upstream action 
passes a specific action state forward.

To set the condition under which this action will execute, right-click and 
select Perform On > Success | Failure | Ignore. Conditional execution is 
available for most actions. However, you can’t test action states in 
monitor and receive actions.

By default, actions only execute when the current action state (as set by 
upstream actions) is Success. Success means that all upstream actions 
have completed normally and set the action state to Success. If you have 
an action configured to execute on Success, it will only execute if all 
previous actions that executed in this workflow report Success. 

The Failure state indicates that at least one action has executed and 
failed to complete normally. If you have an action configured to execute 
on Failure, it only executes if at least one upstream action has reported a 
failure.

You can also configure an action to execute regardless of the current 
action state by selecting Ignore.

USING VARIABLES IN ACTIONS

A variable is temporary job metadata. Variables have a name (such as 
Number of Audio Channels), a type (such as Integer Number) and a 
default value.They can be set inside a job in a variety of ways: Through 
analysis, through metadata population, in the watch and associate 
actions, as a property of an action, or by a service as it executes an 
action.

Note: Variables can also be used in services (configuration is performed 
in the Management Console) - here, they are used for job routing. For 
example, an action with a FibreRequired=TRUE variable must pass this 
condition to a service which evaluates the condition to determine if it can 
successfully perform the action.

Variables are passed from action to action according to the action 
connections. When an action generates a variable, all downstream 
actions can access it. 

Variables are used by actions to control their behavior and workflow logic. 
(Variables are also used by services - and set up in the Vantage 
Console.) 

Many parameters in Vantage can be bound to a variable, allowing the 
workflow to dynamically update parameters on a job-by-job basis. For 
details on binding parameters to variables, see Binding Parameters to a 
Variable.

When a variable is set, that variable value is only available to actions 
within the same branch as the one that set the variable and actions in 
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downstream branches. If two branches merge to a common action, and 
both have specified a value for a variable, then the behavior is 
indeterminate.

Before you can assign a variable to an action, you must create a variable 
template. You create variable templates in the Management Console 
(Templates > Variables). The name, default value, and type of a variable 
is defined in the variable templates.

Adding Variables 
to a Workflow

To add a variable to an action, right-click and select Add Variables. 
Vantage Designer displays the Add Variable window.

In the Add Variables window, you can add variables to the action prior to 
execution. Values set in this window are available to this action, and all 
downstream actions (including actions in connected workflows). This 
allows you to set job metadata as the workflow runs - for example, setting 
the priority of one workflow branch to high, and another to low.

Figure 76. Add Variables window.

Add Variable | Delete Variable 
toolbar icons.
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Click the Add Variables icon in the toolbar to display a list of variable 
templates (which have been previously created in the Management 
Console: Templates > Variables). 

Figure 77. Select Variables window.

Select the variable to add and click OK.

Next, with the variable selected, modify its default static value if 
necessary, and click OK to add it to the variable for use in the workflow.

Note: It is important not to generate the same variable in two actions if 
the branches merge, because the behavior is indeterminate.

Binding 
Parameters to a 
Variable

Most settings in an action can be configured with a static value - one that 
does not change from job to job. For example, you configure a watch 
action to poll a specific directory - and job after job, this directory never 
changes - that is, it is a static value.

However, many actions also have parameters (settings) that benefit from 
being assigned a value at run time - a value the is very likely to change on 
a job-by-job basis - typically, based on the media being processed. 

For example, you may have a message action that generates an email - 
and the subject line in the email should always be the name of the media 
file being processed. Of course, you can’t know the value of the file name 
at design time - only at run time. Or, a variable may be assigned a value 
by an analysis action to determine how many lines of black are at the top 
of a video frame; a crop filter later in the workflow can bind to that 
variable, ensuring that every crop in every job is appropriate to the 
workflow.

To solve this problem, Vantage enables these parameters to be bound to 
a variable, allowing the workflow to dynamically update the value on a 
job-by-job basis. 
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Many parameters in Vantage can be bound to variables. Parameters that 
can be bound to a variable display a green Variable Browse button:

Figure 78. Message action inspector - bindable parameters.

Click the Variable Browse button to display the Select Variable window:

Figure 79. Select Variables window.

The list of variables includes those variables that are present in the 
domain, and are of the correct type for the parameter. For example, the 
subject line parameter only accepts text variables; the email address 
parameters can only accept email address variables.

Parameters that can be 
bound to a variable 
display a green 
Variable Browse button.

Click it to bind a 
variable, which will 
supply its current value 
as the value for the 
parameter.
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Select the variable to bind to this parameter, and click OK.

Figure 80. Message action inspector with a bound parameter.

Now, the parameter displays with a green border, indicating its value is 
derived directly from the current value of the parameter, not the manually 
entered value.

ACTION DETAILS

Actions are the building blocks of workflows. At the top of the workflow 
design panel is the actions toolbar, categorized by action type. Click the 
arrow to open each action type and display the set of actions in this 
group.

Figure 81. Actions are organized by group and type in the toolbar.

You can display the actions toolbar in two ways: right-click in the tool bar 
and select actions and text, or display only actions.

Parameters are bound 
to a variable display a 
green border.

Click Variable Browse 
again to unbind a 
variable, or change 
which variable you want 
to use.
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Binder Mode 
Actions

Certain actions can be used in both file and binder workflows; other 
actions can only be used in binder workflows.

When Workflow Designer is in file mode (Options > Application Mode > 
File), several binder mode actions are deactivated and display in gray:

Figure 82. Action toolbar in file mode.

Notice that in file mode the associate action, both metadata actions, and 
others are deactivated. The following table lists those actions which are 
binder-mode actions, and cannot be used in file mode.

Action States The action state describes the condition of an action execution in process 
and after completion. 

During execution, an action may be Queued | Paused | In Process | 
Waiting. These keywords display in the job status tab of Workflow 
Designer.

After execution, an action’s final state may be Success | Ignore | Failure. 
These keywords may be tested by actions immediately following the 
target action, to determine whether or not following actions should 
execute.Note that this final action state is passed to subsequent actions. 
If an action FAILS, then the next action will inherit the FAIL action state 
and (in most cases) will not execute. 

Similarly, if an action sets the Ignore state, the next action will inherit the 
Ignore state and will likely not execute. Certain special actions, such as 
Message, can be configured to perform on certain states - this allows 
workflows to send an email if they detect a failure.

Table 1. Binder Actions

Associate Move

Compare Receive

Delete Register

Deploy Populate

Forward Transform
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If an action receives states from two incoming actions (such as a merge 
of two branches), then states are given the following priority:

- If at least one incoming state is Failure, regardless of other incoming 
states, the action will inherit the Failure state - Failure has precedence 
over all action states.

- If there is no Fail state, but at least one Pass state, then the action will 
inherit the Pass state- Pass has precedence over Ignore states.

- Only if all incoming states are Ignore, will the action will inherit the Ignore 
state. 

Ignore has lowest precedence of the three states.

Decision-Making 
using Variables and 
Action States

Generally, decision-making is performed in a workflow by adding a decide 
action and configuring it to evaluate variables, then setting an action state 
for its branch.

Figure 83. Decide actions enable you to branch media processing.

Action Types Workflow Designer organizes its actions by type for ease of use. Each 
type and its actions is described in the sections below.

Analysis Actions Use these actions in workflows when you want to perform measurements 
on media files, compare media files, or identify the characteristics of 
media files, and publish the results as variables or metadata labels, or set 
the state of the workflow based on the results.

You can publish analysis results in a metadata label within the binder, or 
you can publish results as variables so that they can be used for decision-
making, or to feed parameters in other actions. In some cases, you can 
also set the action state of the action based on the results of the 
measurement.

Examine Action Use the examine action to analyze the video and audio of a media file, by 
selecting a given analyzer (Black detection, slate detection, etc.).

Compare Action (Binder 
Workflows Only)

Use the compare action to compare two media files.
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Identify Action Use the Identify action to determine the technical properties of a media 
file (for example, frame size, frame rate, codec, bitrate, number of audio 
channels, etc.). 

Catalog Actions

Register Action (Binder 
Workflows Only)

The register action registers the workflow binder in the Vantage catalog. 
This allows Vantage to preserve the binder - and any temporary files 
referenced by it - even after a job expires.

Common Actions Common actions do not have a dedicated Vantage service to perform 
them, and tend to happen instantaneously.

Receive Action (Binder 
Workflows Only)

A receive action provides a starting point for new jobs in Vantage 
workflows that are not started by a watch or other starting action.

Typically, workflows are created with a receive action when they are 
intended for execution by another workflow that immediately precedes 
this one. This ability to chain workflows enables you to create run-time 
customizable workflows consisting of smaller workflow building blocks.

Workflows that end with a forward action are used to start receive action-
based workflows. When you chain workflows, you can pass binders and 
variables between them.

Forward Action (Binder 
Workflows Only)

A forward action forwards a binder and all current variables to another 
workflow, and starts a new job in the target workflow.A forward action may 
be added to the end of a workflow, and requires that the target workflow 
has a receive action as its first action.

Typically, workflows are created with a receive action when they are 
intended for execution by another workflow that immediately precedes 
this one. This ability to chain workflows enables you to create run-time 
customizable workflows consisting of smaller workflow building blocks.

Decide Action A decide action is an action which sets the action state based upon 
variables. It is commonly used to decide whether or not a branch in a 
workflow should execute (it sets the Pass state) or not (it sets the Ignore 
state). 

Note

An origin action is required as the first action in a workflow, even if you 
plan to manually submit jobs to this workflow.
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Note that when the decide action is used, the state gets passed to all 
subsequent actions; as a result, for decision branches more than one 
decide action will usually be used.

Figure 84. Decide actions enable you to branch media processing.

For example, if one branch is for HD, it will start with a decide action that 
will set the state to Pass for HD content, ignore otherwise; if another 
branch is for everything else, it will start with a decide action that performs 
the opposite behavior.

Communicate 
Actions

Communicate actions are used to communicate with external systems.

Message Action A message action is an action which enables you to generate and 
transmit an electronic message - an email, for example. You must 
configure Vantage to use an SMTP server before email can be utilized; 
this can be done in the Vantage Management Console.

Notify Action A notify action is an action which saves job information to a file, or which 
interfaces with an external system. You can configure a notify action to 
produce an XML file, and you can invoke a Web service via a URL.

Metadata Actions Metadata actions are used to convert between attachment files, metadata 
labels, and variables.

Populate Action (Binder 
Workflows Only)

Populate actions transform data between variables and metadata labels.

Transform Action 
(Binder Workflows 
Only)

A transform action transforms data between XML files (attachments) and 
labels. XSL stylesheets are used to perform these transformations; 
stylesheets can be managed through the Vantage Management Console.

Monitor Actions Monitor actions are used to identify new files to be added to a binder, and 
in the case of the watch action, to start a job for this workflow.
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Watch Action A watch action uses the monitor service to continually (and at regular 
periods) polls a target location (a directory, for example) on a device or file 
system (FTP, network folder, etc.) to discover new files. 

When a new file is discovered, the watch action submits a job to the 
workflow which it is part of, for processing the file, typically a media file.

Note: An origin action is required as the first action in a workflow, even if 
you plan to manually submit jobs to this workflow

For details, see the inspector’s man page.

Associate Action 
(Binder Workflows 
Only)

An associate action uses the monitor service to continually (and at regular 
periods) poll a target location (a directory, for example) on a device or file 
system (FTP, network folder, etc.) to discover new files.   

Generally, the associate action uses the file name of an existing media file 
or attachment as the basis for discovering new files; for example, if media 
file Vantage.mpg is currently in the workflow, then the associate action 
may look for Vantage.scc. This behavior can be defined in the associate 
action's inspector dialog.

Associate actions execute until the new file is discovered; subsequent 
actions do not execute until the file is found. When the new file is 
discovered, the associate action makes the file available to other actions 
in the workflow. 

Note: An origin action is required as the first action in a workflow, even if 
you plan to manually submit jobs to this workflow.

For details, see the inspector’s man page.

Transcode Actions The encode action creates a new format of media, using a specific 
encoder profile.

Encode Action Use the encode action to create media of a new format, and save it as a 
file, using a prescribed codec profile. How you configure the encoder 
depends on the encoder you choose.

For details, see the inspector’s man page.

Transport Actions Transport actions perform file operations on files. 

Copy Action Use the copy action to copy a file from one directory to another directory 
on a given file system. In binder mode, the new file will be tracked by the 
workflow - that is, referenced in the Binder. As a result, the new file must 
be given a nickname.

Move Action (Binder 
Workflows Only)

Use the move action to move a file from one directory to another. This 
action deletes the original file. In binder mode, the file may also optionally 
have its nickname changed during the move.

Delete Action (Binder 
Workflows Only)

Use the delete action to delete a file on the specified file system. This 
action also removes the file reference from the binder.
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Deploy Action (Binder 
Workflows Only)

The deploy action copies one or more files to a destination as a single 
action, and may perform additional custom steps depending upon the 
type of deployment.

In binder mode, the deployed files are not referenced in the binder, and 
are not tracked after the action completes.
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G l o s s a r y
action An action is the smallest unit of work that can be specified in a Vantage 
workflow. Actions are connected together in a workflow to perform a 
useful task. Each action must be configured to perform its task in the 
context of the workflow, using an action inspector. Action inspectors are 
specific to each type of action.

Actions are grouped by functional categories: communication, 
transcoding, file operations, metadata processing, etc. Each action is 
defined by the specific task they perform. For example, an email action, or 
a metadata label/file transformation action.

Actions have limited interdependency, and so, are very flexible. You may 
impose limitations on actions in a workflow. For example, you might 
require action B to depend on action A in a Vantage workflow.

Actions - during execution - operate on binders, variables, and states, and 
they generate an action state when they complete. Actions are executed 
by Vantages services, which perform the requirements of the action.

action state The action state describes the condition of an action execution in process 
and after completion. 

During execution, an action may be Queued | Paused | In Process | 
Waiting.

These keywords display in the job status tab of Workflow Designer.

After execution, an action's final state may be Pass | Ignore | Failure. 

These keywords may be tested by actions immediately following the 
target action, to determine whether or not following actions should 
execute.

These action states are passed to subsequent actions. If an action fails, 
then the next action will inherit the Failure action state and (in most 
cases) will not execute. If one action fails, the entire job fails.

Similarly, if an action sets the Ignore state, the next action will inherit the 
Ignore state and will also likely not execute. Certain special actions, such 
as Message, can be configured to perform on certain states - this allows 
workflows to send an email if they detect a failure.

Action states have precedence when an action receives states from 
multiple incoming actions (a merge of multiple branches):



- If at least one incoming state is Failure, regardless of other incoming 
states, the action will inherit the Failure state - Failure has precedence 
over all action states.

- If there is no Fail state, but at least one Pass state, then the action will 
inherit the Pass state- Pass has precedence over Ignore states.

- Only if all incoming states are Ignore, will the action will inherit the Ignore 
state. Ignore has lowest precedence of the three states.

analysis service The analysis service is the Vantage component (operating as a Windows 
service) which executes the actions relating to the analysis of content: 
Examine, Compare, and Identify.

associate action An associate action uses the monitor service to continually (and at regular 
periods) poll a target location (a directory, for example) on a device or file 
system (FTP, network folder, etc.) to discover new files, based on some 
permutation of the name of the file being processed. 

Associate actions can be executed on any action state.

Generally, the associate action uses the file name of an existing media file 
or attachment as the basis for discovering new files. For example, if 
media file Vantage.mpg is currently in the workflow, then the associate 
action may look for Vantage.scc. This behavior can be configured in the 
associate action's inspector.

Associate actions begin executing when a job is submitted, and execute 
until a new file is discovered - subsequent actions do not execute until the 
file is found. When the new file is discovered, the associate action makes 
the file available to the other actions in the workflow.

Configuration is accomplished in the inspector, and is based on the target 
device/file system being monitored and other requirements.

attachment An attachment is a non-media file that is associated with media during 
execution of a workflow. For example, an attachment may be an XML file 
that contains metadata, an SCC caption file, an STL or PAC subtitle file. 
Attachments may also be a PDF file, Excel spreadsheet, or Word 
document, for example. Attachments are identified and processed using 
nicknames for simplicity. Processing is optional - attachments may be 
simply passed through a workflow for storage with the processed media 
and registered in the Vantage catalog.

attachment nickname See nickname.

binder A binder is a collection of media files, attachment files, metadata labels, 
and metadata tracks. All workflows in Vantage operate upon binders. A 
binder allows a Vantage workflow to keep track of dozens of files while 
the workflow executes.

Files within binders are referenced by nickname - that is, a binder is not a 
physical location, rather a collection of references. The underlying files 



may be moved around without changing the nickname of the file. This 
allows a binder to be submitted to, or passed between, workflows without 
requiring that the files be in specific locations.

Binders are referenced by jobs, and by the catalog. If a binder is not in the 
catalog, and not associated with a job, then the binder will be deleted. 
When a binder is deleted, any temporary files (such as media files in 
Vantage Stores) will also be deleted.

binder mode Binder mode is the preferred mode for designing Vantage workflows. In 
binder mode, workflows reference files by nickname and lines connecting 
actions only indicate the execution flow of those actions.

See file mode.

catalog See Vantage catalog.

catalog service The catalog service is the Vantage component (operating as a Windows 
service) that executes actions utilizing the Vantage catalog.

See register action.

common actions Common actions are actions that can be executed by any Vantage 
service; they do not have a dedicated Vantage service.

See receive action, forward action, decide action.

communicate service The communicate service is the Vantage component (operating as a 
Windows service) that executes the actions relating to electronic 
messaging.

See message action, notify action.

compare action A compare action compares media files to calculate certain metrics (for 
example, PSNR). These metrics can generally be published as variables 
or as a label.

console The term console is an informal name for the Vantage Management 
Console. 

See Vantage Management Console.

copy action A copy action is used to replicate a file from a source target (file system/
device and directory) to a destination target (file system/device and 
directory). It typically performs this task by copying the file to the 
destination.

Copy actions can be executed on any action state.



database The term database is the common term used to refer to the Vantage 
database, where all specifications for the domain are stored, along with 
workflows and job history.

decide action A decide action is an action which sets the action state based upon 
variables. It is most commonly used to decide whether or not a branch in 
a workflow should execute (by setting the Pass state) or not (by setting 
the Ignore state). 

Note that when the decide action is used, the state gets passed to the 
next action; as a result, for decision branches more than one decide 
action will usually be used. For example, if one branch is for HD, it will 
start with a decide action that will set the state to Pass for HD content, 
ignore otherwise; if another branch is for everything else, it will start with a 
decide action that performs the opposite behavior.

See variable, action state

delete action A delete action is used to permanently remove a file from a source target 
(file system/device and directory).

Delete actions can be executed on any action state.

deploy action A deploy action is used to save the specified files to a destination outside 
the Vantage domain. Unlike the move or copy actions, deploy actions 
allow multiple files to be deployed simultaneously, and do not maintain a 
reference to those files in the binder after it completes.

Deploy actions can be executed on any action state.

encode action An encode action is used to transcode a media file into another media file 
types.

examine action An examine action evaluates the video and audio of a media file to 
measure certain characteristics, such as audio loudness, or to detect 
characteristics, such as the presence and size of curtains. You can 
configure it to publish metadata or variables containing the results of 
analysis.

file mode File mode is the simplest mode for designing Vantage workflows. In file 
mode, lines connecting actions represent the path that files take through 
a workflow. In file mode, nicknames are not required; if a new file is 
created, subsequent actions will operate on the new file automatically.

File mode has some limitations due to the fact that it does not allow the 
use of nicknames. For example, a delete action cannot be used in file 
mode workflow - it would simply delete the file in the workflow, leaving it 
without a file to process. To access the full functionality of Vantage, 
binder mode is recommended.



forward action A forward action forwards a binder and all current variables to another 
workflow, starting a new job with the target workflow. A forward action 
may be added to the end of a workflow, and requires that the target 
workflow has a receive action as its first action.

Typically, workflows are created with a receive action when they are 
intended for execution by another workflow that immediately precedes 
this one. This ability to chain workflows enables you to create 
comprehensive, intelligent run-time switching workflows consisting of 
smaller workflows used as building blocks.

See receive action.

hot folder A hot folder is a slang term for a directory on a server that has been 
identified as a directory for storing media to be processed by a workflow 
in Vantage. When the workflow monitor identifies new media in this folder, 
it is submitted for processing.

inspector An inspector is a series of one or more panels in Vantage Workflow 
Designer that facilitate the setup and configuration of a given action. 
Inspectors are unique to each action - for example, configuring a watch 
action is very different than configuring an encode action.

identify action An identify action determines technical properties of a media file, such as 
codec type, video bitrate, or file size. This information can then be 
published as a metadata label, or as variables.

job A job is an execution of a Vantage workflow. Jobs have a state (separate 
from action states), and jobs are comprised of actions that are executing. 
Jobs, like actions, may be in-process or they may be complete. 

As a job executes, each action may be performed by any service (on any 
computer) in the Vantage domain that is capable of performing it. The 
capability of a service to perform a specific job depends on its current 
operating state, its workload, and its suitability, defined by qualification 
rules.

Jobs for a given workflow can be viewed in the Workflow Designer by 
selecting the workflow in the Workflow Designer tab and displaying the 
Job Status tab. Alternatively, all in-process and failed jobs within a 
Vantage Domain may be viewed in the Status section of the Management 
Console.

job routing See qualification rule

job state A job state is the current condition of a job. Keyword values are Start | 
Pause | Success | Fail | In Process.

label A metadata label defines a set of metadata by use of name/value pairs 
associated with content. For example, a spot label may contain Agency, 



Author, ISCI, and other metadata values; this set of metadata is 
collectively called a Spot metadata label. Metadata labels are stored in 
binders with the associated media and attachment files.

Vantage supplies several metadata label templates for use in workflows. 
In addition, you can create and modify labels for your use using the 
Management Console (Templates > Metadata Labels).

license A license is stored in the Vantage database. Generally, licenses are 
imported as XML files into the database through the Management 
Console.

media nickname See nickname.

message action A message action is an action which enables you to generate and 
transmit an electronic message - an email, for example. You must 
configure Vantage to use an SMTP server (Management Console: 
Vantage Domain > Settings & Options > Email) before email can be 
utilized.

metadata service The Metadata service is the Vantage component (operating as a 
Windows service) that executes the actions relating to the transformation 
of metadata between labels, variables, and XML files.

See also populate action, transform action.

metadata track A metadata track is time-based or temporal metadata associated with 
media. For example, closed caption metadata is defined as a metadata 
track.

monitor service The Monitor service is the Vantage component (operating as a Windows 
service) that executes the actions relating to the discovery of files and 
starting jobs.

See also watch action, associate action.

move action A Move action is used to move a file from a source target (file system/
device and directory) to a destination target (file system/device and 
directory). It typically performs this task by copying the file to the 
destination, then deleting the source.

Move actions can be executed on any action state.

nickname Nicknames are user-defined strings that are used to reference files within 
a Vantage workflow. Nicknames allow users a convenient way to design 
workflows independent of the actual file locations or underlying file 
names. As a workflow executes, it maintains a collection of underlying 
files called a binder; nicknames allow the workflow to access files within 
the binder.



Nicknames may refer to either media files, or attachment files. Certain 
actions will only allow the use of certain nickname types; for example, a 
transcode action only allows media file nicknames to be used as the 
inputs and outputs. However, other actions (such as move and copy 
actions) operate on any type of file, and allow the use of any nickname.

The use of a nickname does not affect the actual name of the underlying 
file, nor do nicknames have any special meaning. For example, providing 
a media file the nickname Flash does not necessarily mean that the 
media file is in fact a Flash file.

Nicknames can be managed in the Management Console under 
Workflow Design Items > Media Nicknames. Nicknames can also be 
entered manually, directly in the Workflow Designer.

The word Original is a reserved nickname specific to media files.

notify action A notify action is an action which saves job information to a file, or which 
interfaces with an external system. You can configure a notify action to 
produce an XML file, and you can invoke a Web service via a URL.

populate action A populate action uses the metadata service to transform data between 
variables and metadata labels.

Populate actions can be executed on any action state.

qualification rule A qualification rule influences or controls the routing and execution of 
actions among Vantage services of the same type in a distributed 
Vantage domain. Qualification rules can be used to ensure that jobs are 
routed to services that are best suited for the task. Vantage uses values 
contained in variables to determine the suitability of a given service to 
execute the action.

For example, one machine in a domain has specialized hardware - a fibre 
connection. In workflows where move and copy actions require the fibre 
connection, qualification rules specify that the specialized machine (which 
hosts a Vantage transport service) execute those workflows. This is 
accomplished by (1) adding a qualification rule to all other transport 
services in the domain indicating that they cannot executed actions that 
require a fibre card or (2) adding a fibre card required variable to the 
action in the workflow that requires the fibre card.

Qualification rules are exclusively based on variables; they are not based 
on any actual machine analysis. As a result, it is up to the system 
administrator to correctly set up variables and qualification rules, and 
apply variables to the appropriate actions to ensure that jobs are routed 
correctly.

Qualification rules are created and managed in the Vantage Domain 
Console: Vantage Domain > Services.

receive action A receive action provides a starting point for new jobs in Vantage 
workflows that are not started by a watch or other starting action. 



Typically, workflows are created with a receive action when they are 
intended for execution by another workflow that immediately precedes 
this one. This ability to chain workflows enables you to create 
comprehensive, intelligent run-time switching workflows consisting of 
smaller workflows used as building blocks.

Workflows that end with a forward action are used to start receive action-
based workflows. When you chain workflows, you can pass binders and 
variables between them.

See forward action.

register action A register action uses the catalog service to place a binder into the 
Vantage catalog. Register actions can be executed on any action state.

See also Vantage catalog.

service See Vantage service.

transcode Transcode means the process of decoding media in one format (MPEG2, 
for example) down to digital baseband and then encoding it in another 
format (MPEG4, for example). 

transcode service The Transcode service is the Vantage component (operating as a 
Windows service) that executes the encode action - transforming media 
from one format to another. 

See encode action.

transport service The transport service is the Vantage component (operating as a Windows 
service) that executes the actions relating to file operations: move action, 
delete action, copy action, and deploy action.

transform action A transform action uses the metadata service to transform metadata 
between XML files (attachments) and labels. XSL stylesheets are used to 
perform these transformations; stylesheets can be managed in the 
Vantage Management Console: Vantage Domain > Catalogs.

Transform actions can be executed on any action state.

Vantage catalog The Vantage catalog (or simply catalog) allows the management of 
binders that you want to exist past the life of an individual job. Folders can 
be created in the catalog with individual expiration rules.

The catalog and its folders are not a physical location; rather they are a 
way of organizing binders and controlling when the binders - and the 
underlying files - are deleted.

Vantage database A Vantage database is a Microsoft SQL Server database which contains 
all workflows, actions, jobs, binders, licenses, and configuration 
information for a Vantage domain.



Vantage domain A Vantage domain is a specific collection of computers, Vantage 
workflows, actions, services, jobs, binders, configuration settings and 
templates all known to and interacting each other, using a Vantage 
database. This collection constitutes a complete Vantage domain. 
Vantage domains may exist on a single computer or they may be 
distributed across many computers for durability and scalability.

Multiple Vantage domains may exist on a network, but they are 
independent entities that do not communicate with each other. They are 
not bound together and do not share resources or work. The purpose of 
storing an entire domain in a database is to provide an easy way to create 
and manage the domain and to provide access to all the details about 
each resource in the domain to any other resource that needs it.

Vantage folder A Vantage folder is a directory on a supported file system that is stored in 
the Vantage database, which is used in move and copy actions. Unlike 
Vantage Stores, files placed in a Vantage folder are not deleted when the 
binder is deleted. Vantage folders are used for output folders of files.

Vantage folders are managed in both the Vantage Management Console 
and Vantage Workflow Designer. Changes to a Vantage folder - such as 
updating an IP address or a password - immediately affect all workflows.

Vantage Management
Console

The Vantage Management Console (usually referred to informally as the 
console, for short) is a Windows MMC program that enables Vantage 
system administrators to effectively configure Vantage domains, and 
scale domains across multiple servers to meet their operating 
requirements and perform effectively in their environment.

Vantage service The term Vantage service refers to the collection of software components 
(operating as Windows services) in Vantage that implement and execute 
the actions in a workflow as it executes as a job. 

Vantage store A Vantage store is a directory on a Windows file system that used for 
storing temporary files. Stores are managed by the Vantage domain for 
the purpose of centralizing large directories for reading and writing files. 
Unlike a Vantage folder, files placed in a Vantage store are deleted when 
the binder is deleted. Vantage stores are generally used to hold 
temporary files for the duration that a job is executing.

Vantage stores are managed in the Vantage Management Console: 
Vantage Domain > Storage. Services that create temporary files, such as 
the Transcode service, can be configured to use specific stores.

Vantage Workflow
Designer

Vantage Workflow Designer is a program that enables you to create and 
edit workflows, activate and deactivate them, and monitor their status and 
review jobs in process and jobs that have completed.

variable A variable identifies temporary job metadata. Variables have a name 
(such as Number of Audio Channels), a type (such as Integer Number) 



and a default value. Variables values can be set inside a job in a variety of 
ways: Through analysis, through metadata population, in the watch and 
associate actions, as a property of an action, or by a service as it 
executes an action.

Variables are used by Vantage services and actions to control their 
behavior and workflow logic. The majority of parameters in Vantage can 
be bound (or attached) to variables, allowing the workflow to dynamically 
update on a job-by-job basis. 

For example, a variable may be assigned a value by an analysis action to 
determine how many lines of black are at the top of a video frame; a crop 
filter later in the workflow can bind to that variable, ensuring that every 
crop in every job is appropriate to the workflow requirements.

Variables in services may be also be used for job routing. For example, 
an action with a FibreRequired=TRUE variable must pass this condition 
to a service which evaluates the condition to determine if it can 
successfully perform the action.

The actual name, default value, and type is a Variable Template. Variable 
templates are created in the Management Console (Vantage Domain > 
Templates > Variables) and assigned for use in actions and services.

variable template A variable template identifies a variable, including its name, description, 
type, and default value. Variable templates are created in the 
Management Console. Variable templates must be pre-defined, prior to 
assigning a variable from this template for use in services or in actions.

watch action A watch action uses the monitor service to continually (and at regular 
periods) poll a target location (a directory, for example) on a device or file 
system (FTP, Windows network folder, etc.) to discover new files.

When a new file is discovered, the watch action submits a job for the 
workflow which it is part of, for processing the file - typically, a media file.

workflow A workflow in Vantage is a set of actions designed to perform an 
automated process. Vantage workflows are created using the Vantage 
Workflow Designer by adding and configuring actions and connecting 
them together. Workflows are stored in the Vantage database, and 
executed by Vantage services.

Workflow Designer Short for Vantage Workflow Designer. Also sometime called just 
Designer, for short. See Vantage Workflow Designer.
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A

action
templates, creating 70

action states 76
actions

adding to a workflow 65
binder mode only 75
binding parameters to a variable 73
configuring, generally 69
connecting together 65
detailed view, showing/hiding 52
details of 74
invalid connections 68
re-ordering 69
setting conditional execution 71
states of 76
uncrossing connection lines 68
using variables with 71

actions toolbar, using 51
Activate button (workflow) 48
analysis actions 77
associate action 79
auto-arrange, disabling temporarily 69

B

binder file nickname view 52
binder mode

generally 64
binding parameters to variables 73

C

catalog actions 77
category

creating new 50
deleting 50

category (cont’d)
renaming 50

common actions 77
communicate actions 78
compare action 77
conditional execution 71
connecting to a domain 46
connection lines

uncrossing 68
copy action 79
copyright notice ii

D

Deactivate button (workflow) 48
decide action 78
delete action 80
deploy action 80
detailed view, showing/hiding 52
domain 89
domain, connecting to 46

E

Edit button (workflow) 48
encode action 79
examine action 77

F

file mode
generally 64

forward action 78

G

generally 51
grid lines, showing/hiding 52
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inspectors
using, generally 69

J

Job Status tab, generally 57
job submitting, manually 60

M

manual job submission 60
message action 78
metadata actions 78
MMC 89
monitor actions 79
monitor status tab, generally 54
move action 80
MPEG disclaimers iii

N

nickname view 52
notices, legal, generally ii
notify action 78

P

parameters, binding to variable 73
Pause for Priority, in transcode actions 59
pausing transcode actions 59
populate action 79

R

receive action 77
register action 77
Release button (workflow) 48
resuming transcode actions 59

S

starting and stopping Workflow Designer 45
Submit Job button 49
support, obtaining xiii

T

tech support, obtaining xiii
Telestream

contacting v
information about xiii
International xiii

Telestream (cont’d)
mailing address xiii
sales and marketing xiii
technical support xiii
Web site xiii

Telestream,
contacting xiii

Telestream, contacting xiii
trademark notice ii
trademark notices ii
transcode Actions 79
transcode actions

Pause for Priority 59
transcode actions, pausing and resuming 59
transform action 79
transport actions 79

U

uncrossing connection lines 68

V

Vantage
Web site for xiii

Vantage domain
changing 46

Vantage Workflow Designer, see Workflow 
Designer 45

variables
adding to a workflow 72
binding with parameters 73
generally 71
using for decision making 76

variables view 52

W

warranty iv
Warranty and Disclaimers iv
watch action 79
Web site URL xiii
workflow

activating 49
adding actions 65
centering in workspace 53
creating new 50
deactivating 49
deleting 51
design techniques, generally 64
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workflow (cont’d)
details panel, using 48
duplicating 51
editing 49
moving in workspace 53
moving to another category 51
releasing 49
renaming 50
zooming in and out 53

workflow category
see category 50

workflow design tab 51
Workflow Designer

starting and stopping 45
submitting jobs manually 60

workflow status buttons 48
workflows

building, generally 63
workflows panel, generally 49

Z

zooming a workflow 53
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